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1  SmartPTT Dispatcher

1.1  SmartPTT Dispatcher Interface

SmartPTT Dispatcher interface can be divided into the following sections:

1. Main Menu which also contains Quick Launch Buttons.

2. Main Area

3. Information Bar

Main Menu

The Main Menu bar contains options and commands which allow you to carry out the majority of the functions

available in the application.

Quick Launch Buttons provide you a quick access to some functionality of the application. Currently, there are 3

such buttons.
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 The Conference Call button opens the Conference Call window where you can hold conference calls.

For more information about this function see Conference Calls.

 The Telephone Subscribers button opens the Telephone Subscribers window which allows you to

make calls to telephone subscribers from SmartPTT Dispatcher.

 The Dispatchers button opens the Dispatchers window which allows you to make calls to external

dispatchers from SmartPTT Dispatcher.

There are also other menu items represented by an icon:

 The Settings button opens the Settings menu which allows you to configure system parameters, create

special rules, which will help you manage workers, connect external third-party devices and so on.

 The Help button opens the Help menu where you can read the help file, learn about the application or

check for updates.

 The UI Layout Settings button is very useful as it allows the dispatcher to remember the layout of the

Main Area (the position of opened windows and panels). Thus, next time the dispatcher opens the application, he

or she won't need to open the windows all over again. The dispatcher can simply click the this button and select

the layout he or she used earlier. For more information see User Interface Layout.

 The Change Operator button allows you to change the operator. At clicking on this button the dispatch

console is restarted, and you can select another operator in the Authorization window.

Main Area

The Main Area is a central area of the application window and is used for opening functional windows and panels

when operating in the application.
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Information Bar

The Information Bar was designed to give the user information about the number of unread messages, the

selected subscriber,  the owner of the license and the application version. Here you can also see a special icon

which notifies about the approaching license expiration date.

1.1.1  Change Layout

There is an ability to adjust the layout of the opened panels in the Main Area. In order to do that, click on the tab

of the opened panel, drag it to the location where you would like to place it and release. As soon as you start

dragging the panel, new icons appear on the screen. The icons represent a new location of the panel on the

screen.

The table displays description of the icons.

Icon Description

Appears inside a panel, which means that you can either place the panel in

any of the four positions beside the panel or insert it as a tab inside the

panel.
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Icon Description

The four standalone icons can be used to place the panel in any position of

the Main area outside any other panel.

1.2  Map
SmartPTT supports different maps, like Google Map, Open Street Map, vector maps of various formats, raster

maps, polish format maps. Together with many useful tools like showing and animating a track, defining points of

interest, maps provide the dispatcher with a better control over radio subscribers. You can open Call Window by

double-clicking on the radio subscriber displayed on the map, or open Action List by clicking with the right mouse

button.  

Polish Format Maps

To open a polish format map, expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and click

Map (Polish format). In the opened window select the map file in a MP format.

Google Map

To open the Google Map, expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and click

Google Map.

Raster Map

To open a raster map, expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and click Raster

map > Open map. In the opened window select the file in a MAP format.

To create a map based on a map image, see the Raster Map section.

INGIT Map

To work with INGIT vector maps in SmartPTT Dispatcher, the GWX ActiveX Control application (version 6.1), the

registration key (HASP) and INGIT vector maps are required.

Note: The GWX ActiveX Control software is designed to build INGIT vector maps into independent applications as

a unit, which provides mapping service as a part of these applications. GWX ActiveX Control is purchased once
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and then allows you to use various INGIT vector maps. Each map must be purchased separately. See the

purchase conditions on the INGIT company website (http://www.ingit.ru).

GWX ActiveX Control Installation

To install GWX ActiveX Control:

1. Insert the disk with maps into your CD or DVD drive and insert your HASP into the USB.

2. Click Proceed with the installation of GWX Active-X Control.

3. Click Install GWX-6.1 ActiveX Control.

Read carefully and accept License Agreement.

4. Follow instruction of Setup Wizard:

· Upgrade your HASP driver if Setup Wizard asks you.

· If manual installation is required, download the latest HASP driver installer from the supplier site and follow

the instructions provided.

· Select the maps you want to add. Make sure that GWX-6.1 ActiveX Control is also selected.

5. After the installation run Register GWX ActiveX Control.

When GWX ActiveX Control is installed and the software components are registered, it is possible to work with the

maps, allowed by licenses embedded in HASP. HASP must be plugged into the USB of your PC.

To open an INGIT map, expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and click INGIT

Map. In the opened window select the map file in a CHART format.

Note: If the map failed to load, restart Register GWX ActiveX Control.

MapInfo Map

To set a MapInfo map for SmartPTT Dispatcher, expand the Map menu in the Main Menu bar and click MapInfo

Map > Map Settings. In the Map Settings window click Add and in the opened window select a map layer – a

file in a TAB format. You can add multiple TAB-files and determine the drawing order of the layers using the

arrows on the right. To delete a layer, select the TAB-file and click Delete.

http://www.ingit.ru
http://sentinelcustomer.safenet-inc.com/sentineldownloads/?s=&c=End+User&p=HASP4&o=all&t=all
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Min. Object Size to Show on Map (pixels) – minimum size of the object displayed on the map in pixels.

Affects the detail level of the displayed map.

Scale to Draw Layer : 1 : – scale factor for a layer. The layer objects will not appear on the map when you are

zoomed in or out beyond the specified scale.

In the Map Description File field specify the path to the map file. Click Save when you are finished. The file will

be saved in a SPMAP format. To open the map right after you saved it, click Save and Open.

To open a MapInfo map, expand the Map menu in the Main Menu bar and click MapInfo Map > Open Map. In

the opened window select the file in a SPMAP or TTKGP format. You can create a map in the TTKGP format

using the TatukGIS Viewer free version (http://www.tatukgis.com/Products/EditorViewer/Editions/Viewer.aspx).

Open Street Map

To open the online Open Street Map, expand the Map menu in the Main Menu bar and click Open Street map

> Open Online Map. 

http://www.tatukgis.com/Products/EditorViewer/Editions/Viewer.aspx
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To open the offline Open Street Map, expand the Map menu in the Main Menu bar and click Open Street Map >

Open Map from File. In the opened window select a map file in an OSM or TILESURL format.

To open the Open Street Map from local server, expand the Map menu in the Main Menu bar and click Open

Street Map > Settings. In the Data Source for OpenStreetMap Online field specify the path to the local

server. If you want to get back to the default address, clear Data Source for OpenStreetMap Online and click

OK. 

MapPoint Map

To work with MapPoint maps in SmartPTT Dispatcher, you must first install Microsoft MapPoint on this PC.

Europe or North America version depends on required target coverage area.

Note: All versions of Microsoft MapPoint show a simple outline map of the world when zoomed and scrolled

outside of their target coverage area. National borders and a large number of cities are shown outside the target

coverage area. For the target coverage area, road detail and internal subdivisions such as provinces, parishes,

counties, states are shown.

To open a MapPoint map of Europe or North America, expand the Map menu in the Main Menu bar of SmartPTT

Dispatcher and click MapPoint Maps > MapPoint "Europe" or MapPoint "North America".

To open a MapPoint map file created in Microsoft MapPoint earlier, expand the Map menu in the Main Menu bar

of SmartPTT Dispatcher and click MapPoint Maps > Open MapPoint Map File. In the opened window select

the map file in a PTM or PTT format.

How to Use Maps

To move the map press and hold the left mouse button, and move where necessary. Or use arrow keys to move

(this is applicable to the offline map).

To zoom in scroll the mouse wheel forward. To zoom out scroll the mouse wheel back. You can also use the keys

"+" and "-" to zoom in and zoom out.
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Majority of maps allow you to display the object address. To do this, right-click at any place on the map—the

object address will be shown.

Certain types of maps may have the additional functions such as a context menu. Right-click on the map. At that,

the context menu appears.

Using this menu you can:

1. Search on the map

2. Select elements to be labeled on the map.

3. Change the map’s appearance.

4. Select the map's rendering type.

5. Display the object address at any place on the map, where the given menu is opened.
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1.2.1  Raster Map

To set raster map settings, expand the Map menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Raster Map > New Map. At that, the configuration window is displayed for creating geographic raster maps

based on an image.

To create a map, select the map image using the browse button .

On the selected map image mark reference points (crossroads, places of interest, etc.) with the help of Google

Earth and calculate their coordinates. Coordinates are calculated in the following way:

Longitude and Latitude = Degree + ((Minute * 60) + Second) / 3600 (this s a conversion from degrees, minutes

and seconds into normal values), where X and Y are corresponding coordinates (in pixels) on the image.
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The longitude corresponds to the horizontal coordinate (X) and the latitude corresponds to the vertical coordinate

(Y). The longitude value can range from -180 degrees (the most distant longitude to the west from the Greenwich

Meridian set to 0) to +180 degrees (the most distant longitude to the east from the Greenwich Meridian). In fact -

180 degrees and +180 degrees are the same longitude. The latitude value can range from -90 degrees (the South

Pole) to +90 degrees (the North Pole).

Longitude and Latitude coordinates, already converted into normal values and corresponding to the subscriber's

current locations, are also shown in the subscriber's Call Window.

You need four points. Point selection criteria are:

· Point 1 is located as close as possible to the top left image corner.

· Point 2 is located as close as possible to the top right image corner.

· Point 3 is located as close as possible to the bottom left image corner.

· Point 4 is located as close as possible to the bottom right image corner.

After all coordinates are entered, click Finish. In the opened window set the raster map name and click Save.

To edit or check object locations in the created raster map, click Open. Locate the raster map in the window

which is displayed.

Note: The created raster map files and the image map file must be in the same folder.

1.2.2  Raster Maps From Database

SmartPTT Dispatcher allows you to work with large raster offline maps with a size of more than 5000х5000 pixels.

The functionality is used for displaying SmartPTT system objects located at a long distance from each other. This
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is achieved by dividing the original raster image into pieces and storing them in the database.

To create the database for the raster map, send your query to our technical support service and attach the raster

map image in a JPEG format with the list of geographical positions on the map (e.g., in a TXT or MAP format).

Geographical positions are necessary to anchor image points to the geographical coordinates. The list of

geographical positions must contain four points at the corners of the map. In response to your request our

technical support specialist will provide you the database backup of the map in a BAK format.

Note: If the attachment(s) size exceeds the limit of 50 MB, split the file to several small files using the archiver or

file manager, or upload it to the file hosting service. In the latter case include a link to the file in your query

message.

Then restore the database from the received backup. For more information see How to restore from SmartPTT

Dispatcher database backup.

After the database is restored, expand the Map menu in the Main Menu bar and click Raster Map From

Database > Settings. Click Scan Databases in the opened window, and you will see a list of all available maps

stored in the databases of the selected server (see Database Settings, the Database Server Name field).

http://support.smartptt.com/hc/en-us/requests/new
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Name – name of the map stored in the database. To change the name of the map, double-click on the name in

the Name field and enter a new name.

Database – name of the database.

Show – if the check box is selected, the map is available in the Map menu. To open the map, expand the Map

menu and select the required map under Raster Maps From Database.

To remove the map from the list, select the map and click Delete. To save your changes, click Save. If you want

to undo the last changes, click Cancel.

1.2.3  Indoor Tracking

Big organizations with huge premises require constant control over their employees' displacement inside

buildings. For this purpose Indoor Tracking system was implemented. Indoor Tracking system allows getting data

from special beacons and transmitting it to SmartPTT Dispatcher or any other client application using API.

Contact our technical support (http://support.smartptt.com/hc/en-us) for SmartPTT Client API documentation. 

Currently, SmartPTT system supports the following technologies and products:

· iBeacon technology: with the use of MOTOTRBO radios with the firmware version 2.6 and above and the

beacons that support iBeacon technology,

· Blufi option boards (RF800) with special beacons (Connect-RTLS RF800), and

http://support.smartptt.com/hc/en-us
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· Kilchherr option boards (K-TERM 44) with special beacons (K-TERM 70IC Beacon Transmitter).
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Note: The Indoor Tracking feature is available only for MOTOTRBO radios with the firmware version 2.6 and above

or for radios with special option boards (see above). Also, it is necessary to configure special settings in

SmartPTT Radioserver Configurator and SmartPTT Dispatcher. The required settings for SmartPTT Radioserver are

described in the Indoor Tracking section of the SmartPTT Radioserver Configurator help file.

To enable Indoor support for a radio subscriber in SmartPTT Dispatcher, open the Properties window of the radio

subscriber and in the Location tab select Indoor Tracking.

 

Note: If you use Motorola source (iBeacon technology), the Update Interval field must be selected and specified

together with the Indoor Tracking field for enabling Indoor support for a radio subscriber.

To create a building plan, expand the Map menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Indoor Tracking > New. In the Floor Plan window you can create a plan of the building floor or of a multi-

storey building.
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Building Name: A name of the building plan.

To add a floor of a building, click the Add button. To remove a floor of a building, select it from the list and click

Delete. To change the floor order inside the building, use the Up and Down buttons.

Floor: A name or an ordinal number of a floor in a building. To change the name of the floor, click the old name in

the Floor field and type a new value.

File Path: A path to the floor plan file. You can use a floor plan in a DWG format or a raster image. To attach a

plan to the floor, click the  button and select the required file.

Note: DWG (DraWinG) is a binary file format used for storing two and three dimensional design data and

metadata. It is the native format for several CAD packages including nanoCAD, AutoCAD, IntelliCAD.

Save: You can save the floor or the building plan changes to a SPLANX (archive) format.

To open a building plan, expand the Map menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Indoor Tracking > Open. To control more than one building at the same time in SmartPTT Dispatcher, you

can open several Indoor Tracking panels.

Building Floor Plan

Save: You can save the building plan changes to a SPLANX file.

Save As: You can save a copy of the building plan with another name.
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View Mode (2D or 3D): A mapping of the building plan in a two- or three-dimensional form. This feature is

available only for floor plans in a DWG format.

Add Beacon: You can add a beacon to the building plan. For that, in the Beacon Settings window specify the

beacon number and name in the corresponding fields and click OK. At that, the beacon icon  appears instead

of the mouse cursor. Place it on the map where the beacon is located and left click.  If you use Motorola source,

specify the number of the beacon in the Beacon Number field in the Major.Minor format, where the Major value is

separated from the Minor value by a dot. Major stands for the group number of the beacons and Minor stands for

the individual number of the beacon in the group. If you use the BluFi or Kilchherr source, specify the Beacon IDs

in the Beacon Number field. If the beacon name is not specified in the Beacon Name field, the value from the

Beacon Number field will be shown as a beacon name on the building plan. To remove the beacon from the plan,

double-click on the beacon and in the opened window click Delete.

Geofences: Allows you to unite the existing beacons to control the radio subscriber's moving about the building.

These geofences are used in Indoor positioning rules. 

Routes: Allows you to create routes for radio subscribers. These routes are used in Indoor positioning rules.

Edit Plan: Opens the Floor Plan window that allows you to change the floor name, the floor order inside the

building, or the floor plan file.

Grid Size: The grid size of the building plan. For building plans based on raster images, the Grid Size option is

not available.

Label Size: The size of the radio subscriber and beacon labels displayed on the building plan.

Beacons: Select a color for a beacon label.

Radio Subscribers: Select a color for a radio subscriber label.

Subscribers on Indoor Map: A list of radio subscribers who support the Indoor Tracking feature. Select the

check box, to display the radio subscriber's label on the building plan.

Subscribers' tracks: Here you can record tracks of radio subscribers and watch them in real time, or check old

records. To watch the radio subscriber move about the building, click Add Track. In the opened window specify

the following parameters:

· Subscriber: The name or radio ID of the radio subscriber.

· Source: The radioserver whose data will be used for building a track. If the drop-down list is empty, check

that Event log is created and activated in SmartPTT Radioserver Configurator.

· Color: The color of the future subscriber's track.
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· Start Date: Start time and date of the track record.  

· End Date: End time and date of the track record. To watch the radio subscriber moving in real time, select

Update in real time.

Show All: Shows tracks of all the radio subscribers from the Subscribers on Indoor Map list. You can see

details of each track. To open Track details, click :

Clear All: Removes all the track records displayed at the moment.

The following buttons allow user to control the way the building plan is displayed:

Button Description

Zooming up the marked area of the building plan. Click the button, then left-click on the

building plan and mark the necessary area.

Zooming up or zooming out the entire building plan. To zoom in, click the button and

withholding the button pressed move the mouse pointer up. To zoom out – move the

mouse pointer down. Also, use the wheel button to change the scale of the building

plan.

Moving the building plan. Click the button and withholding the button pressed relocate the

plan.

Fits the scale of the building plan to the size of the Indoor Tracking Overview Map

panel.

 Available only for three-dimensional building plans. Allows changing the angle of the displayed

building plan.
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1.2.4  Geofences

Geofences help dispatchers to keep an eye on the radio subscribers. A dispatcher can define the area of the

geofence on his or her own and attach Positioning rules to it.

You can add a geofence in two ways:

1. By drawing a geofence on the map. For more information see Geofences.

2. By specifying coordinates of the geofence. You will learn about it in this article.

To add a geofence by specifying its coordinates, expand the Map menu in the Main Menu bar of SmartPTT

Dispatcher and click Geofences. In the opened window you can add a new geofence or modify settings of the

existing one – name, color, and whether it should be displayed on the map:

Name – the geofence name.

Color – the geofence color on the map.

Show – enables the option to display the geofence on the map.

Note: Whether the geofence is displayed on the map or not, the rules set for the geofence are enabled. To assign

a rule to the geofence, go to Positioning Rules.
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Add the zone-forming points of the new zone. To do that, click Add in the Geofences window. To edit the zone-

forming points, select the zone and click Edit or double-click the required zone in the list.

In the Geofence Coordinates window type the name of a new zone, specify the color of a new zone and a pair of

longitude and latitude values for a zone-forming point. To edit point coordinates, place the cursor into the required

field and type new value. You can't create a zone with less than 3 longitude and latitude pairs. To delete the

points, click Delete.

To delete a geofence from the list, select the geofence and click Delete.

1.2.5  Points of Interest

Points of interest (POI) identify location of special interest which are shown on the map and can be quickly found

in SmartPTT Dispatcher. A point of interest consists of the point name, location coordinates and the picture.
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To add a point of interest, expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and click Points

of Interest.

The Points of Interest window allows you to change the name of the existing point of interest and whether it

should be displayed on the map. To modify the existing point of interest, select it and click Edit or double-click

the required point of interest in the list. To delete the point of interest, select it and click Delete.

To add a new point of interest, click Add.
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Name – name of the point of interest.

Latitude – latitude coordinate of the point of interest.

Longitude – longitude coordinate of the point of interest.

Picture – the image which represents the point of interest on the map. Maximum image size of the point of

interest is 64×64 pixels. Images of the bigger size are be automatically cropped to 64×64.

Show on Map – enables the option to display the point of interest on the map.

You can also create a point of interest from the Tools menu. For more information see Points of Interest panel.

1.2.6  Routes

The route is a polyline connecting key points of the network coverage area. Subscriber location near the key

points is identified by the specified radius of the route and can be summarized in the Subscriber Location Report.

To specify the route parameters (Color, Radius, Coordinates), expand the Map menu in the Main Menu of

SmartPTT Dispatcher and click Routes. In the opened window you can add a new route or modify settings of the

existing one.
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Name – the route name.

Color – the route color on the map.

Radius – the allowed deviation from the route.

Show – enables the option to display the route on the map.

To add a new route, click Add. To modify route settings, select a route from the list and click Edit or double-click

the required route in the list.

In the Route Coordinates window specify the route name, the route line color, the acceptable deviation from the

route for the radio subscriber, coordinates of the route points and its properties. Key Point is used for singling out

particular places of the track on the map. You can give a name to each key point to be displayed on the map. The

key points are represented by small white squares on the map. Select Show on Map to display the route on the

map.
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To delete the route, select it from the list and click Delete.
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The route example:

 

You can also create a route from the Tools menu. For more information see Routes panel.

1.2.7  Show Track

GPS tracking is very helpful for seeing real-time positions of the radio subscribers you are tracking. In addition,

the Show Track feature allows the dispatcher to see where a radio subscriber was during a particular time period.

Note: By default, GPS coordinates are not saved in the database. If you want to save GPS coordinates, open the

Positioning Systems window in the Settings menu and select Save GPS Locations in Database.
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To specify draw parameters of the track, expand the Map menu in the Main Menu of SmartPTT Dispatcher and

click Show track. The Show Track window opens.

Subscriber – defines subscriber whose track is to be displayed.

Source – defines the source, which database will be used for drawing the track. If Dispatcher is selected, the

data is taken from the local database. Apart from Dispatcher, any available radioserver can be chosen as a data

source. In that case all data is taken from the database of the chosen radioserver.

Color – the track color on the map.

Line Thickness – thickness of the track line on the map.

Start Date, End Date – the time frame of the track.

1.2.8  Animate Track

To animate displayed tracks, expand the Map menu in the Main Menu bar of SmartPTT Dispatcher and click

Animate Track.
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The Track Animation window opens.

Run track animation

Stop track animation

Pause

Run track animation slower

Run track animation faster

During track animation you can slow it down or make it faster. The system remembers the last track animation

speed and uses it during next track animation. 
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Here is an image of a sample track on the map.

To clear the tracks shown on the current map, expand the Map menu in the Main Menu of SmartPTT Dispatcher

and click Clear Shown Tracks.

To clear the shown tracks on all maps, expand the Map menu in the Main Menu of SmartPTT Dispatcher and

click Clear Shown Tracks on All Maps.

1.2.9  Coverage Map

Coverage maps give you information about signal strength (RSSI) of a particular radio in a particular place. To build

a coverage map for a radio subscriber, make sure that he has GPS enabled, and there is GPS data in the

database.

Warning! SmartPTT 9.0 supports the “Coverage Map” function in systems with MOTOTRBO Network

Interface Service 2.60 or earlier. Support for newer MOTOTRBO Network Interface Service versions is

implemented in SmartPTT 9.1.
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To build a coverage map, click Map > Coverage map > Show.

All subscribers: Select this option to build a coverage map for all the subscribers on the list.

Select subscribers: Select this option to build a coverage map for the selected subscribers only.

Select categories: Select this option to build a coverage map for all the subscribers of the selected category. 

Source: Defines the source, whose database will be used for drawing the track. If Dispatcher is selected, the data

is taken from the local database. If a radioserver is selected, the data is taken from the database of the chosen

radioserver. 

Grid: Defines a radius for checking signal strength. The system of units selected in Settings > Positioning

systems > System of Units will be applied to this field. 

Start date / End date: Defines over which period the data will be used for the map.
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The example of the coverage map:

The Coverage Map Settings window identifies the colors used for different RSSI ranges in the coverage map.

You can adjust the legend on your own, change colors for different RSSI ranges, add and delete RSSI ranges. To

do it, click Map > Coverage map > RSSI ranges.
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To clean the map, select Map > Coverage map > Hide.

1.3  Event Log
The Event Log allows you to see what is going on in the system. The event log displays status and event

messages from SmartPTT system, and other useful information.

To open the event log, click Event Log in the Main Menu bar and then All Events. To tune Event Log settings,

see Event Log.

You can limit the number of displayed data by setting a period of time. To do this, click Events for Period in the

Events menu. The Period dialog is displayed. Specify start and end date for entries displayed in the log.
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To display only not read messages in the log, select Unread Messages.

The system event log appears as follows.

Alerts and event initiated in the emergency mode colored red in Event Log.

The event log of SmartPTT Dispatcher contains the following columns:
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By default, all the columns are displayed in the log. To hide or show columns in the log, right-click on the menu

with column names and select the necessary columns.

Column Name Description

Direction

Shows whether the event is incoming or outgoing. You can tell the direction by the

arrows: the green one stands for the incoming event, and the blue one—for the outgoing

event.

Event Type

Shows the type of the event. It can be a call, registration, a block command, a

message, change of a status, an alarm, a telemetry command, a job ticket, enabling or

disabling the lone worker mode, the Radio Kill command and other.

Date/Time Shows the date and time of the event.

Not Read Shows if the message was read or not.

Additional

Information

Additional information includes: text messages, titles and description of tasks, initiators

and contributors of group calls, and other.

Operator

This column exists in

the event log of the

dispatch console only.

Shows the operator of the dispatch console who participated in the event.

Radioserver Shows the name of the radioserver used in the event.

Dispatcher

This column exists in

the event log of the

radioserver only.

Shows the operator of the dispatch console who participated in the event.

Channel Shows the channel on which the event was registered.

Subscriber
Shows the subscriber who can be a source or target in the event. Here you can also

see all the subscribers who talked in a group call. 

Source Shows the event initiator name or ID

Talkgroup Shows the talkgroup which participated in the event.

Status Shows the status of the event ("Message delivered", "Power down", etc.)

Duration Shows how long the event lasted in seconds.

Connection Type Shows the connection type of the event. It can be IP, PBX and DMR.
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Column Name Description

This column exists in

the event log of the

dispatch console only.

Repeater IP

This column exists in

the event log of the

dispatch console only.

Shows the IP address and port of the repeater which was used.

Destination Shows the radio ID or name of the target radio subscriber or talkgroup.

Record Shows if you can play the record or not.

Lone Worker Shows if the lone worker profile is assigned to a radio subscriber.

Note Contains the text which the dispatcher added to a record.

You can filter the event log by any of these columns. You can also filter the event log by the Not Read column by

clicking There are unread messages: in the Information bar.



39Event Log

Dispatcher User GuideSmartPTT PLUS 9.1

Click any column name, so the log sorts its contents according to this column content. You can filter the content

displayed in the log using filters.



40Event Log

Dispatcher User GuideSmartPTT PLUS 9.1

To group the log entries, click the column title and drag it to the area labeled as "Move column header here for

grouping".

If you want to have particular columns to be always seen in the log regardless of the scroll position, use the

special element in the column titles. Just drag it after the column you want to be always there.

To listen to audio records of the calls, select the call in the event log and click the Play Selected Records button

. 

Note: To enable recording of calls, go to Settings and select Records. There select Record Calls.
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The Play Records window for selected records opens.

After the record playback window opens, selected records are reproduced automatically, starting from the earliest

date.
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Player buttons:

 Start Playback plays the selected record and all the records of the list without stopping. 

 Pause Playback pauses playback of the current record. Clicking the Start Playback button resumes

playback of the record from the place of suspension.

 Stop Playback stops playback of the current record. Clicking the Start Playback button enables playback

of the record from the beginning.

 Return to Previous Record plays the previous record after the current one.

 Go to Next Record plays the following record after the current one.

Settings:

 Play All Records enables the mode of all records reproduction in turn. Playback is controlled by the

previously described buttons.

 Replay enables the mode of replaying the current record or all the records in turn if the Play All Records

mode is activated.

Button  opens a subscriber call window. Button  opens a window for message sending. 

Opening Radioserver Event Log

Depending on SmartPTT system configuration the event log can be saved either on the dispatcher side or the

server side, or both. 
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To open the event log saved at the radioserver:

1. Open the radioserver Action List and select Show Radioserver Event Log.

2. Select the Start and End Dates to show events of the period. The Radioserver Event Log is displayed
in the same way as the Dispatcher Event Log in a separate tab.

To make subscriber radio activity report based on the radioserver data, in the Main Menu select Reports >

Radio Activity Report. In the opened window specify the period of time, source, channel, grouping and click OK.

1.4  Tools
From the Tools menu you can open all the panels used in SmartPTT Dispatcher. 

These are the following panels:

· Calls panel displays the ongoing call activity and call history in the radio network.

· Sound panel allows you to monitor and adjust the signal volume.

· Cross Patches panel allows you to connect talkgroups from different frequency bands or from different

network types dynamically.

· Radio Fleet panel displays a list of radio subscribers registered in the system.

· Subscribers panel for quick access to the subscribers.

· Job Tickets panel from where you can create and supervise job tickets.

· Lone Workers panel to show lone workers' status, for example, that a lone worker did not call for a longer

period than expected, etc.

· Latest Incoming Calls panel, which gives you information of the recent voice calls made.

· Notifications panel to get information about the alarms configured by the dispatcher.

· System Messages panel, which displays errors, disconnection of the radioserver, etc.

· Server Tasks panel to display server tasks in the background
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· Map Tools contains all the available map tools of the dispatch console: Points of Interest, Routes,

Geofences, Subscriber Location panels.

· Custom Сonsole panel created by the SmartPTT Dispatcher to manage subscribers, talkgroups or control

stations.

1.4.1  Calls

The Calls panel displays the ongoing call activity and call history in the radio network.

The first time you install SmartPTT, the Calls panel opens automatically. The panel can also be opened or closed

manually. To do this, expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Calls.
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A call record in the Calls section contains several elements.

In the Capacity Max systems, a call record in the Calls section also contains the Cross button that is used to

end the call during the hang time or to decline the call.

From the Calls panel the dispatcher can do the following:

· Answer the ongoing call by clicking anywhere on the call record.

· See the ongoing call activity. The call status can be determined by the color of the call record.

· See history of all registered calls, time of call and its duration.

· Make all types of call by clicking the button with the subscriber name.

· Decline the incoming call by clicking the Cross button or right-clicking the call record (in the Capacity Max

systems only).

· End the call during the hang time by clicking the Cross button or right clicking the call record (in the

Capacity Max systems only).

Call status is determined by the color of the call record:

1. Light yellow – outgoing call attempt, or a call in the queue (in conventional systems).
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2. Yellow – all outgoing radio calls.

3. Green – all incoming radio calls or radio monitoring.

4. Light green – incoming call to SmartPTT Dispatcher in the Capacity Max systems only.

5. Blue – none of the parties transmit or receive voice (hang time). The subscriber or the dispatcher can

continue the call by pressing the PTT button within hang time. After the hang time expires, pressing the

PTT button will initiate a new call. In the Capacity Max systems the dispatcher can end the call during

the hang time by clicking the Cross button or right clicking the call record.

If the Calls section is empty, to make a call to a radio subscriber, select the subscriber under Radio Fleet and

click the PTT button. The corresponding call record will appear in the Calls section and the call will be initiated.

1.4.2  Sound

The Sound panel allows you to monitor and adjust the signal volume.

To open Sound panel, expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Sound.

The  button allows you to adjust the speaker volume.

Selected objects: allows you to adjust the volume for selected objects.

Unselected objects: allows you to adjust the volume for unselected objects.

System sounds: allows you to adjust the volume for system sounds.
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The  button allows you to adjust the microphone volume.

1.4.3  Cross Patches

Cross Patches allow you to connect talkgroups from different frequency bands or from different network types very

quickly. A call made to a cross patch will be heard by all participants of this cross patch. Also, a call made to a

talkgroup included in the cross patch will be heard by all participants of this cross patch (this is true even for a call

made by the dispatcher).

A cross patch is created in the dispatch console and controlled by the dispatcher. When the dispatch console

gets closed, all the cross patches created in this dispatch console will be saved. 

To create a cross patch, do the following:

1. Open the Cross Patches panel from the Tools menu (if it's not open).

2. Add a cross patch. To do this, in the Cross Patch panel click on the Add Cross Patch button:
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3. In the new Cross Patch window select objects of the future cross patch. To add the selected object to the

cross patch or to remove it from the cross patch, click the corresponding arrows or double-click on the

mouse button. Then click Enable.

The new cross patch will appear in the Cross Patches panel.

In the Cross Patches panel you can do the following:
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· Filter the list of cross patches to see active cross patches or all cross patches (the Active and All options).

· Make a call to all the parties of the cross patch by clicking on the PTT button.

· Perform actions from the Action List of the cross patch: enable or disable the cross patch, edit its properties,

mute or unmute it, and delete it from the list. To open the Action List, click :

Enable / Disable – turns on/off the cross patch.

Mute / Unmute – turns on/off the sound for all parties of the cross patch. If the cross patch is muted, the

dispatcher won't hear any party, but all the cross patch participants will hear the dispatcher. If the cross

patch is unmuted, but one of the participant talkgroups is muted, the dispatcher will hear all the others, but

not this talkgroup.

Note: If the cross patch contains groups from network topologies based on control stations and direct connection,

and you can hear hoarse voice, select DMR Vocoder as a codec in the sound settings in the dispatch console

(Settings > Sound) and in the audio settings of the control station (SmartPTT Radioserver Configurator > Control

stations > Audio):

1.4.4  Radio Fleet

The Radio Fleet panel displays a list of radio subscribers registered in the system.
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The first time you install SmartPTT the Radio Fleet panel opens automatically. To open or close the Radio Fleet

panel manually, expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher window and click

Radio Fleet.

The radio subscriber list consists of the following columns – object, status and the PTT button. The Object field

shows the name of the subscriber or radioserver. The Status field displays the current status of the radio

subscriber. The PTT button initiates a call.

To edit the list of subscribers, use the  buttons. You can show or hide

talkgroups, show or hide online or offline radio subscribers. Also, you can 

filter radio subscribers by the categories. To do that, click Filter by category . To filter radio subscribers

by the channels, click Filter by channel .
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The entry field under the  buttons allows you to search a radio subscriber by

name or ID.

To filter the radio subscribers by a status, select the required status form the list.

The  and  allows the dispatcher to add a new radio subscriber or delete the existing subscriber.

Radio subscribers not added in SmartPTT Dispatcher are considered unregistered and displayed in italic in the 

Radio Fleet panel. Unregistered subscribers are displayed in the list of subscribers after a radio is turned on and

registration on the radioserver is successfully completed.
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 — GPS coordinates of a radio subscriber are outdated or missing.

 — GPS coordinates of a radio subscriber are valid. Validity period of GPS coordinates is defined by the

Validity of GPS coordinates parameter in Settings > Positioning Systems. 

Note: The icons  and  are displayed if GPS support is enabled in the Properties window of a radio

subscriber and at least one location update criterion is selected.

Action List

The  button opens the Action List including a list of actions which can be applied to a radio subscriber, the

radioserver, a control station or a talkgroup. 
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The Action List of the radioserver

Show Radioserver Event Log – displays the radioserver event log for the specified period of time. For more

information on the event log see Radioserver Event Log.

Configure Call Bridging Table – redirects to the routing configuration window.

Main Device – shows what audio output device is currently used for the radioserver. You can also change to

another device.

View Properties – opens the radioservers's Properties window.

The Action List of a hardware control station
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Exit Emergency Mode – disables emergency mode.

Note: The Exit Emergency Mode action becomes available after a radio subscriber sends the emergency signal.

Radio Dekey – forced interruption of calls on the channel. This option is available only for hardware control

stations and in IP Site Connect network.

Reset Control Station – resets the control station. Only hardware control stations can be reset.

Mute or Unmute – turns off/on the control station mute mode.

Mute Others – leaves sound on only for this control station; other control stations are muted. 

Main Device – shows what audio output device is currently used for the control station.To change to another

device, select a specific output device or Inherited device, i.e., the device selected for the higher level, in this

case, for the radioserver.

View Properties – opens the control stations's Properties window.

The Action List of a virtual control station
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Radio Dekey – forced interruption of calls on the channel. This option is available only for hardware control

stations and in IP Site Connect network.

Reset Control Station – resets the control station. Only hardware control stations can be reset.

Mute or Unmute – turns off/on the control station mute mode.

Mute Others – leaves sound on only for this control station; other control stations are muted.

Main Device – shows what audio output device is currently used for the control station.To change to another,

select a specific output device.

View Properties – opens a window there you can specify some information.
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The Action List of a talkgroup

Exit Emergency Mode – disables emergency mode. The Exit Emergency Mode action becomes available only

after a radio subscriber has sent the emergency signal.

Send Message – opens a window for creating and sending messages.

Call Mode – available only in the Capacity Max systems and shows the current call mode for the talkgroup:

· Standard Call stands for the two-way Group Call

· Broadcast Call stands for the one-way Group Call.

Note: All talkgroups in the Capacity Max systems are broadband groups. So, the Group Call for these talkgroups

in any call mode is broadcasted over all the sites associated with the talkgroups.

Make Conference Call – opens the Conference Call window and starts the conference call.

Call Telephone Subscriber – opens the window with the list of registered telephone subscribers.

Mute / Unmute – turns on/off mute mode for this group.

Main Device – shows what audio output device is currently used for the talkgroup. To change to another device,

select a specific output device.

The Call Window of a talkgroup contains some of the actions available to the talkgroup. The main function of the

Call Window is to give the ability to apply actions to the talkgroup and to view the action log. To open the

window, double-click on the talkgroup.

View Properties – opens the Properties window of the talkgroup.

The Action List of an All Call limited to a site
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Mute / Unmute – turns on/off mute mode for the All Call. This can be useful if you don't want to hear the All Call

initiated by another dispatcher.

Main Device – shows what audio output device is currently used for the All Call. To change to another device,

select a specific output device.

View Properties – opens a window where you can add a comment about the All Call.

The Action List of a radio subscriber
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Exit Emergency Mode – disables emergency mode. The Exit Emergency Mode action becomes available after

a radio subscriber sends the emergency signal.

Send Message – opens a window for creating and sending messages.

Send Call Alert – sends a call alert to the subscriber.

Radio Check – sends the radio check command to the subscriber radio.

Note: If the connection to the Capacity Max system is performed via control station, the Radio Check command

will be unavailable.

Monitoring – allows you to listen to the radio subscribers without their awareness.

Set Location – allows you to define location of a radio unit on the map manually, without GPS data. If GPS

support is enabled in the radio subscriber's Properties window (in the Location tab), the location set manually

has a validity period which is defined in the Positioning Systems settings in the Validity of GPS coordinates

field. If GPS support is not enabled in the radio subscriber's Properties window, the location set manually is

always valid.

Find on Map – shows the subscriber on the map. If there are more than one subscriber on the same position on

the map, the subscriber's label will placed above all other labels.

Show Address – displays the subscriber address based on the current GPS coordinates. If it is impossible to

define the address, the notification No Coordinates appears. When you reopen Call Window (after it was

closed), previously received information on the address is not displayed.
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Remove from Map – removes the subscriber from the map.

Find on Indoor Map – shows the subscriber on the building map. The Find on Indoor Map action is available

for a radio subscriber if the Indoor Tracking check box is selected in the Properties window of the radio

subscriber.

Block Radio – sends the Block Radio command to the subscriber radio.

Unblock Radio – sends the Unblock Radio command to the subscriber radio.

Make Conference Call – opens the Conference Call window and starts the conference call.

Call Telephone Subscriber – opens the window with the list of registered telephone subscribers.

Create Point of Interest – creates POI at the current place of the subscriber. If there are no coordinates, the

system uses the latest coordinates received from the radio. If coordinates are absent altogether, nothing happens.

Create Deferred Action – opens a window for creation of a deferred action.

Main Device – shows what audio output device is currently used for this radio subscriber. To change to another

device, select a specific output device.

View Properties – opens the subscriber's Properties window.

Call Window
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The Call Window of a radio subscriber contains some of actions available for the radio subscriber. The main

function of the Call Window is to give the ability to apply actions to the subscriber and to view the action log. To

open the window, double-click on the radio subscriber. To customize the appearance and behavior of the Call

Window, to the Call Window settings.

Making a call

The PTT button is located in several places: in the Radio Fleet panel and in the Call Window. Depending on the

call status, the PTT button can be displayed in the following colors:

1. Light yellow  – outgoing call attempt, or a call in the queue (in conventional systems).

2. Yellow  – all outgoing radio calls.

3. Light green  – incoming call attempt to SmartPTT Dispatcher in the Capacity Max systems only.

4. Green  – all incoming radio calls or radio monitoring.

5. Blue  – none of the parties transmit or receive voice (hang time). The subscriber or the dispatcher

can continue the call by pressing the PTT button within hang time. After the hang time expires, pressing
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the PTT button will initiate a new call. In the Capacity Max systems the dispatcher can end the call

during the hang time by right clicking PTT in the Call Window.

To call a radio subscriber in any system, except Capacity Max:

1. Select the subscriber from the Online Subscribers list

2. Click PTT next to the subscriber name or press the specified keyboard hot key. At that, the PTT button

changes its color to light yellow, and then to yellow. The caller subscriber will hear your voice.

3. Click PTT again to give the subscriber an opportunity to respond. At that, the color of the PTT button

changes to blue.

4. When the subscriber starts to respond, the color of the PTT button changes to green.

To call a radio subscriber in the Capacity Max systems:

1. Select the subscriber from the Online Subscribers list.

2. Click PTT next to the subscriber name or press the specified keyboard hot key. At that, the PTT button

changes its color to light yellow. The subscriber will not hear your voice and will see two options on the radio

display: Accept or Reject.

3. When the subscriber presses PTT on his radio and accepts the call, the color of the PTT button on your

console changes to green. At that, you can hear the subscriber.

4. When the subscriber finishes to talk and releases PTT on his radio, the PTT button on your console

changes to blue (hang time). During the hang time you can either continue or end the call.

5. To continue the call, click PTT again. At that, the PTT button changes to yellow. The caller subscriber will

hear your voice.

6. To end the call, click the Cross button in the Calls panel or right-click the corresponding call record or PTT

in the subscriber's Call window.

Sending messages

To send a message to a subscriber, click  in the Call window of the radio subscriber or click Send

Message in the Action List.
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Save Template – saves the typed message as a template.

Delete Template – deletes a template selected in the list of templates.

Send – sends the typed message to the subscriber

Cancel – the Text Message window closes and the message is not sent.

You can also send a message using the Type text and press Enter field.

How to change subscriber name using radio

A subscriber can easily change his or her name by using the radio. At that, the new name will appear in the 

Subscriber panel.

To do it, you need to send the text message profile%name:<new name> to the Slot ID set in your system.
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Before sending:

After sending the message:
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The Properties Window

To open the Properties window of the radioserver, control station, talkgroup, radio subscriber, dispatcher or

telephone subscriber, right-click on the corresponding item.

The Properties window of the radioserver

Server Version – the version of the radioserver. If the version of SmartPTT Radioserver does not match the

version of SmartPTT Dispatcher, the version number is displayed in red.

Comments – text field for additional information.

The Properties window of the hardware control station
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The window displays information on the control station, for example, model number, serial number, control station

type, frequency range, firmware version, control station identifier.

You can change the channel of the control station by selecting it from the list or clicking arrow buttons.

The Volume slider allows you to set a volume on the channel. This option also effect on the emergency alert and

subscriber voice at the emergency call.

The Properties window of the virtual control station

The window displays an information about the control station, for example, serial number, firmware version, control

station identifier, type of network configuration.

The Volume slider allows you to set a volume on the channel. It also regulates the volume of the emergency alert.

Note: The adjusted volume level of the selected channel affects the volume of all incoming voice calls (including

emergency calls) on all the audio devices of the given channel.

The Properties window of the talkgroup
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Comments – text field for additional information.

Click the Telemetry button  to select telemetry command for the talkgroup.

The Properties window of the subscriber

The Common tab:

IP – IP address of the radio subscriber to identify the subscriber radio. If the IP field is absent, specify CAI and

Radio ID.

MDC ID – the identifier used to identify Motorola Data Communication (MDC) messages. You cannot type more

than 4 hexadecimal numbers into this field. It is used in the analog and the mixed modes.

5 Tone ID – the radio subscriber identifier. If the radio works on the analog channel and supports the 5 Tone

signaling (SelectV). It must match the 5 Tone Radio ID in the General Settings tab of the radio MOTOTRBO

CPS settings. To be set in the range from 0 to 9 or from A to G.

Note: Several IDs can be used as the radio identifier. If the radio is used on the analog channel only, just 5 Tone

ID or MDC ID must be filled, and the CAI and Radio ID or IP fields must be empty.

Name – the subscriber’s name.

Status – the subscriber’s status.

Select – click to upload the radio subscriber's image if there is any. To delete the selected image of the user,

click the cross symbol on the left to Select.

 – click the button to select the icon of the subscriber.
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 – click the Telemetry button to specify telemetry actions to the radio subscriber.

Lone Worker – select the check box to assign the Lone Worker Profile to a radio subscriber. Select from the

list the profile of the lone worker.

Note: You can add lone worker profiles in SmartPTT Dispatcher in the Settings menu under Lone Worker Rules.

The Location tab:

GPS – select the check box to see the subscriber on the map. The subscriber radio must support GPS.

Note: To set up GPS for the SmartPTT Radioserver, specify the required settings described in the GPS section of

the SmartPTT Radioserver Configurator help file.

The Update location area allows you to specify the location update criteria:

with time interval, s – the time interval in seconds after which the GPS coordinate request will be sent to the

radio subscriber.

Note: You can set the main time interval for receiving GPS coordinates in the subscriber Properties window. The

minimum interval for receiving GPS coordinates is set in SmartPTT Radioserver Configurator (Radio Network

Services > GPS > Minimum location update interval). Therefore, if the interval set in the Properties window

is less than that set in SmartPTT Radioserver Configurator, GPS coordinates will be received at the interval set in

SmartPTT Radioserver Configurator.

with distance interval, m – the distance interval in meters or feet after which the GPS coordinate request will be

sent to the radio subscriber.

on GPIO pin status change – the GPS coordinate request will be sent to the radio subscriber when the status of

telemetry contacts changed.

on emergency – the GPS coordinate request will be sent to the radio subscriber when the radio subscriber

sends an emergency alarm.
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Indoor Tracking – select the check box to see the subscriber on the building plan by the dispatcher request (the

Find on Indoor Map action) or after the predefined time period (the Update Interval, s field in the Location tab

of the radio subscriber Properties window). The subscriber radio must support Indoor Tracking. If you use

Motorola source (iBeacon technology), the Update Interval field must be selected and specified together with the

Indoor Tracking field for enabling Indoor support for a radio subscriber

Note: To set up Indoor Tracking for SmartPTT Radioserver, specify the required settings described in the Indoor

Tracking section of the SmartPTT Radioserver Configurator help file.

Update Interval, s – the time interval in seconds for location data update from special beacons, which are

installed in buildings. The field is mandatory in case of Motorola source (iBeacon technology) use.

The Custom tab contains subscriber's custom properties, which were added by the system administrator. If there

are no any added custom properties, the Custom tab is absent.

1.4.5  Channels

The Channels panel allows you to see all the active control stations available in the system.

You can do the following in this panel:

· Make an All Call or a group call depending on the selected type of call.

· Mute or unmute the channel. If the channel is muted, the dispatcher won't hear the talkers on the channel.

· View information about the current call on the channel: the call state, the called party and the call originator.
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· Perform other actions from Action List. The actions in Action List may be different. This depends on

whether the channel is physical or virtual. For more information on Action List of control stations see Radio

Fleet in the Help file of SmartPTT Dispatcher.

1.4.6  Subscribers

The Subscribers panel provides convenient interface to perform voice calls, to edit properties of radio subscriber

and to filter the list of radio subscribers by generating a list of control buttons for radio subscribers.

To open the Subscribers panel, click Main Menu > Tools > Subscribers.

You can perform the following actions on the Subscribers panel:

· filter the list of radio subscribers by various criteria,

· customize the list of radio subscribers,

· call to a radio subscriber,

· find the necessary radio subscriber in the filtered list by its name or radio ID, using the Search field.

· open the radio subscriber Call Window, by right clicking the corresponding control button on the panel, and

· open the radio subscriber Actions List, by clicking the button .

The Subscribers panel contains the following filter criteria:
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All subscribers: All registered radio subscribers (online and offline).

Online: Online radio subscribers only.

Manual selection: Customized list of radio subscribers.

Categories: Radio subscribers of the specific category, predetermined in the Categories window. If there are no

any added categories, this filter is absent.

The All subscribers, Online, Manual selection, Categories filter criteria show in brackets the number of radio

subscribers in the list, filtered by one of these criteria.

Statuses: Radio subscribers with the selected status. The statuses are predetermined in the Statuses window. If

there are not any added statuses, this filter is absent.

Note: The Statuses criteria is applied to the list of radio subscribers already filtered by one of the following

criteria: All subscribers, Online, Manual selection, or Categories.

To customize the list of radio subscribers, select the Manual selection radio button and drag the necessary

radio subscribers to the panel from the Radio Fleet panel. To delete the radio subscribers from the customized

list, select the radio subscriber and press the Delete button.

To make a call to a radio subscriber, click the radio subscriber button, or select the radio subscriber and press

the PTT button. The PTT settings defined in Control Devices are applied to this panel.

You can distinguish between radio subscribers’ states on the panel. Different states differ by color of the control

button and the frame around it. The colors are the same as in Custom Consoles.

: the icon on the subscriber button shows that the dispatcher did not answer the radio subscriber call. The

figure next to it shows the number of missed calls.

1.4.7  Job Tickets

The Job Tickets panel allows creating special assignments for radio subscribers or talkgroups and tracking their

performance.

Note: This functionality is supported only by MOTOTRBO SL Series portable radios. When a job ticket is sent to

the radio, which does not support this functionality, it comes as a message, for example, <JTS> Job Ticket ? 1

Create weekly report.

To create a job ticket, expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Job Tickets.
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The Job Tickets panel can be divided into three parts:

· Filters

· Job Ticket List

· Status Change Log

The filters arrange the list of job tickets to the operator's taste. 

You can hide job tickets from the job list after the particular status is achieved. To do that, deselect the Show

complete job tickets check box.
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To create a job ticket, click Add.

Name – job ticket name. It is a required field.

Description – description of the job ticket. Also required field.

Validity period – defines the time period during which a job ticket can be assigned to offline radio subscribers.

After this validity period expires, the job ticket is never sent. If a job ticket is not completed before the validity

period has expired, the job ticket gets the status "Outdated".

Assigned – job tickets can be assigned to an individual radio subscriber or to a talkgroup. To do this, simply drag

a subscriber or a talkgroup in this field. To remove the assigned subscribers, select the subscribers from the list

and press DELETE.

After creation, the job ticket will be displayed in the job list with the default status value. When the radio

subscriber changes the job ticket status, the status in the job list will be changed accordingly. If the job ticket is

assigned to a talkgroup, the job ticket table will contain the name of the radio subscriber, who changed the job

ticket status. Job tickets can be assigned to offline subscribers too. As soon as offline subscribers become

online, they get the job tickets (if the validity period has not expired). 

To see the history of changes for job ticket statuses, click on the job ticket status. At that, the Status Change

Log table will display the information about status updates.
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To cancel the job ticket and delete it from the job list, click Delete. At that, the radio subscriber, to whom the job

ticket was assigned, will receive a text message that the job ticket was canceled (only if Send notification to

subscriber when uncompleted job ticket was deleted by dispatcher is checked in Job Ticket Statuses). 

If the job ticket has not been delivered (see Status Delivery) for some reason, or if you want to resend the

existing job ticket to a radio subscriber or a talkgroup, click Resend. In this case, the edit window will open, and

after clicking OK, a job ticket with a unique number will be sent. Use of unique numbers is important for job ticket

resending, because radios ignore job tickets with same titles. Therefore, before resending a job ticket, make sure

automatic numbering is enabled (Settings > Job Ticket Statuses).
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To get information about job ticket statuses for a period, when the dispatch console was turned off, click Get

Update Status.

1.4.8  Monitoring

Monitoring

The Monitoring panel is a complex tool which gives a comprehensive outlook on the whole radio system. 

It includes four panels:

1. Monitoring

2. Topology

3. Diagnostics

4. Event Log

Monitoring – graphical representation of data and voice received from MOTOTRBO repeaters, which allows

observing the ongoing system operation. Each logical channel has a section for displaying transmitted packets in

the form of colored vertical bars. The height of the bar corresponds to the level of the received signal; and the color

corresponds to the event type according to the legend. In order to see the radioserver and its network in the 

Monitoring tab, make sure that the Monitoring service is enabled for this radioserver in SmartPTT Radioserver

Configurator.
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To use Monitoring in “SmartPTT Dispatcher” you should activate it in the “SmartPTT Radioserver Configurator”

program. You can learn how to activate and configure it from “SmartPTT Radioserver Configurator User guide”.

Graphical representation of data packets is displayed only for the selected network. 

Note: The list on the left shows only active networks (IP Site Connect, Capacity Plus, Linked Capacity Plus) of

SmartPTT Radioserver. If a network becomes inactive, it disappears from the list. 

Show Details – when selected, events from different slots appear in separate blocks.

Show Summary – when selected, events from different slots appear in one block. 

When checking both parameters, all the three blocks are displayed.

Data displayed in blocks:

Name Description

Call All Call, group calls, private calls, remote monitoring, emergency calls
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Name Description

Telephone call Telephone calls

ARS
Registration information, that is information about radio availability in the network (ARS

service).

GPS GPS coordinates of the radios (GPS service)

ТMS Text messages (TMS service)

Telemetry Telemetry commands and signals

Indoor Data from beacons showing radios' locations inside a building (i.e., Indoor Positioning).

System
System events from and to MOTOTRBO equipment (data confirmation, private call

confirmation, alarms, remote monitoring (only a command), Radio Check and some other).

Levels displayed on the right to the blocks (High, Medium, Low) correspond to the RSSI level ranges: -80 or more

(High), -80 to -100 (Medium) and -100 or lower (Low).

The event log at the bottom of the screen gives more detailed information, namely the type of transmitted data

(ARS, GPS, Message, Emergency Call, etc.), date and time of the event, its duration, initiator's and addressee's

IDs, repeater ID and RSSI level, site ID (applied to LCP systems only), network name.
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Topology

Topology – schematic representation of active networks. A network topology is set in SmartPTT Radioserver

Configurator and displayed in SmartPTT Dispatcher.

Note: In order to see the radioserver and its network in the Topology tab, make sure that the Monitoring service

is enabled for this radioserver in SmartPTT Radioserver Configurator.
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Graphical objects used in topology:

Graphical Object Description

Major alarm on device or no connection

Device is connected or no alarms registered on device.

Minor alarm is registered on device or there are more than 5

packets lost or corrupted.

Repeater is turned off.

Repeater is not connected. This symbol is used only for the

repeaters added in SmartPTT Radioserver Configurator in the 

Network Configuration tab.

SmartPTT Radioserver

Network in folded state

Virtual repeater (i.e., SmartPTT Radioserver), or MNIS

Slave hardware repeater

Master hardware repeater

Master virtual repeater

Repeater is not connected, but it is included in the peer map.

Repeater is connected, but it is not in the peer map.
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Graphical Object Description

Location in a folded state. 

Location in an unfolded state.

Uninterruptible power supply

Router

Unknown device (any other device)

Note: Network configuration is set in SmartPTT Radioserver Configurator. Repeaters, which are added but not

active, are marked red. If network configuration is not set in SmartPTT Radioserver Configurator, the network

topology will be generated automatically based on the information received from the available network repeaters. If

the radioserver is stopped, it disappears from the topology screen.

Repeater loading on both logical channels is displayed above each repeater.

 

Loading grows steadily, not sharply, until the maximum value. When both logical channels are used, the

maximum value is 100%, when only one logical channel is used— 50%.

A busy channel is represented by a yellow LED on the repeater.
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Repeater ID is displayed under repeater.

Application peer ID is specified in SmartPTT Radioserver Configurator (Peer ID).

Note: All the repeaters used in one network should have unique ID's.

1. Radioserver

To fold and unfold the network, right-click on the radioserver and select Fold or Unfold respectively.
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To view radioserver parameters and the ongoing performance information, right-click on the radioserver image and

select Information.

Operating System – provides information on the OS used on the server.

Processor Load – displays current CPU load and other information about PC memory.

Hard Disks – provides information on the the available hard disks of the PC and their characteristics.

Network Interfaces – displays the network interface and the sub network mask of the PC.
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Sensors – displays platform status (for example, system temperatures, voltages, fans, power supplies and

chassis intrusion).

To operate remotely, right-click on the radioserver image and select Control. To be able to control the radioserver

remotely, make sure that IPMI parameters are set in the settings of the radioserver. If the IPMI settings are

correct, the following window will open:

Power Status – shows the current status of the radioserver. There can be three statuses:

· Switched On

· Switched Off

· N/A Unknown (in this case check that IPMI settings are correct)

Power Management (OS) – allows users to turn off the radioserver at the OS level.

Power Management (hardware) – allows users to turn on/off or to hard reset the radioserver computer at the

hardware level.

Note: If the radioserver computer is blocked, you can turn off the radioserver computer only at the hardware level.

If you have more than one radioserver, you can arrange them in the Topology tab either vertically or horizontally.

The layout can be selected in the Layout dropdown at the bottom of the Topology tab. The selected layout is

applied not only to radioserver elements, but to all elements, which can be folded and unfolded. 
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2. Repeater

To view repeater parameters and statistics, right-click on the repeater element and select Information.

Repeater parameters:

Name Description

Repeater Repeater ID

IP-address Repeater IP-address

Model Repeater model number

Firmware Version Version of firmware used in repeater

Codeplug Version Repeater parameter block version



86Tools

Dispatcher User GuideSmartPTT PLUS 9.1

Name Description

Serial Number Repeater serial number

Voice Calls Ability to transmit voice (Yes, No)

Data Calls Ability to transmit data (Yes, No)

Statistics:

Name Description

Channel Loading (%) Channel loading on repeater for the last 10 seconds

Transmissions Started Number of times the PTT button was pressed

Registration (ARS) Number of registration packets transmitted for the last minute

GPS Number of GPS coordinates transmitted for the last minute

Messages Number of text messages transmitted for the last minute

Telemetry Number of telemetry packets transmitted for the last minute

Broken Packets (RX) Number of packets (Rx) with errors, received for the last minute 

Maximum Number of Broken

Contiguous Packtes (RX) 

Maximum number of broken packets (Rx) in a row

Number of Transmit Collision

Packets (TX)

Number of not transmitted packets due to collisions on the

channel

Uptime The time during which the repeater is available in the network
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To operate remotely, right-click on the repeater element and select Control. At that, the following window opens.

Note: You cannot operate virtual repeaters remotely, therefore, the Repeater Control window is available only for

hardware repeaters connected to the radioserver.

Current Channel – channel used by the repeater. Channels are set in repeater settings with the help of

MOTOTRBO Customer Programming Software (MOTOTRBO CPS). 

Power, TX – transmitter power of repeater. There are high and low modes. Bands for both modes are specified in

MOTOTRBO CPS.

State – allows switching the repeater to “active” or “not active” mode. When in the “not active” mode, repeater

does not transmit any signals. To switch the repeater to the “active” mode, select On in the State field. 

Restart – allows restarting repeater remotely.

Apply – applies settings specified in the Repeater Control window. 

Close – closes the Repeater Control window without making changes in the repeater settings.

3. Uninterruptible Power Supply (UPS)

To view parameters and status information of a UPS, right-click on its symbol and select Information.

Identification:

Name Description

Model UPS model

Serial Number Device serial number 

Firmware Firmware version

IP-address IP-address
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Name Description

Network Mask Network mask

State:

Name Description

Alarm Details Informs about issues in UPS operation

Input Power Source Input Power Source

Output Power Source Output Power Source

Last Battery Replacement Date and time when battery was replaced last time

Parameters:

Name Description

Input Voltage (V) Input voltage level (V)

Input Frequency (Hz) Input frequency level (Hz)

Output Voltage (V) Output voltage level (V)

Output Frequency (Hz) Output frequency level (Hz)

Output Current (A) Output current level (A)

Output Power (W) Output power level (W)

Load (%) Eaton UPS loading in percent

Battery Charge (%) Battery charge left in percent

Charge Left (hh:mm) Battery charge left in hours and minutes

4. Router

To view parameters and other information of a router, right-click on the element and select Information.

Alarms – gives information about issues in the router operation.
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5. Unknown Device

Unknown device is any kind of device.

To view information on the device, right-click on the element and select Information.

Parameters:

Name Description

System Name Name of the device

System Description Description of the device

Alarm Details Informs about issues in the device operation

6. Location

To change the way Location is displayed, right-click on the Location element, or click on the Plus/Minus icon.

There are two display modes: 

· Folded

· Unfolded

Folded – location is displayed as an image inside a box.
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Unfolded – displays which devices, repeaters and routers are used in this location.

To change the default image of Location, right-click on the object. At that, a drop-down will appear where you can

either upload your own image or set the default image.
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Diagnostics

Diagnostics – provides information about the current state of the connected MOTOTRBO repeaters and alarms.

To select columns to be displayed, right-click on the menu bar with the column names. At that, the following list

opens.

Note: By default, all columns are enabled.

On the right side of the panel you can find all the technical information about the repeater selected in the table,

including the repeater's statistics, its properties, and alarms (if there are any). You can also get the latest

information on RSSI levels per slot and other parameters by clicking the Refresh button under Diagnostics.  
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Event Log

The event log of monitoring is one of the best ways to learn about hardware alarms, for example, it informs about

repeater connection or about the states of connected routers and UPS. 

Note: Events with severity "Critical", "Major" and "Minor" are highlighted with red, pink and yellow respectively.

Besides reviewing current events, Event Log provides the ability to view saved events for the particular time

period.

To review events for a time period, select Show Logged Events, define the period limits by using the calendars

for start and end dates, select the radioserver from the drop-down and click Apply.

1.4.9  Lone Workers

The Lone Workers panel displays the list of subscribers who are in the Lone Worker mode and their current

status. This was designed for a better supervision over lone workers.

To open the Lone Workers panel, expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher

window and click Lone Workers. At that, the following window opens.
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The Lone Workers panel shows radio subscribers working in the Lone Worker mode marked with specific color.

The color shows if the subscriber meets the requirements set for the lone worker profile the subscriber belongs to:

· Light gray – the lone worker did not violate the rule.

· Yellow – rule violation: the event, described by the rule, has occurred. Alert Timer starts. 

· Red – the lone worker did not react in a specified way after Alert Timer expired.

Note: For more information how to set rules for lone workers, please see Lone Worker Rules.

To turn off the Lone Worker mode, click the cross button.

1.4.10  Latest Incoming Calls

The “Latest Incoming Calls” panel shows the latest subscribers who made a call in the radio network. It also

provides quick access to the call window of the subscribers.

To open the panel, on the Tools menu click Latest Incoming Calls.

To call a subscriber, click it in the panel. This opens the Call Window of the subscriber.

To change the number of subscribers in the panel, change the Notification Panels settings.

1.4.11  Notifications

The Notification window informs the dispatcher that the set of rules were not fulfilled and the alarms were

activated. 

The following rules are displayed in the Notifications window:

· Rules and Alerts

· GPS Rules
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· Lone Worker Rules

When the specified event happens and one of the rules triggers, the notification window opens up automatically to

display the alarm notification.

The usual notification is composed of the following parts:

· Caption

· Subscriber name and time

· Text of the alarm

1.4.12  System Messages

The System Messages panel shows you messages on events related to the radio network functionality.

Messages inform you about:

· the statuses of the connections to the radio networks,

· the statuses of the connections to the radio network components,

· the activity statuses of the network components,

· the statuses of the connection to the server and more.

You can see three types of messages:

· error messages for losing a great functionality, for example:

· warning messages for losing a minor functionality, for example:
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· information messages about getting or restoring functionality.

You can configure rules for message appearance in the Events and Notifications menu.

You can learn a source of the event from the message:

· Client, i.e. the SmartPTT Dispatcher program,

· Server, i.e. the SmartPTT Radioserver program,

· Client-Server Connection,

· Database, i.e. the SmartPTT Dispatcher database,

· Your radio network and its components.

You can also see a time of the event and commentary on it.

You can show the System Messages panel in two ways:

· On the Tools menu, click System Messages. The System Messages window appears.

· by configuring its automatic showing in the System Messages menu.

To close the System Messages panel click Close  .
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Examples of warning messages:

This message appears when amount of records in the database exceeds 90% of the maximum size of the

database. It will appear at the start of SmartPTT Dispatcher and will reappear every 30 min until database is

not cleaned up.

In rare cases you can see a message that database in 100% full. It appears only when 0.005% of free space

left in the database.

Examples of error messages:

This message indicates that amount of records in the database reached its maximum. It will appear at the start

of SmartPTT Dispatcher and will reappear every 30 min until database is not cleaned up.

1.4.13  Server Tasks

The Server Tasks window shows the list of commands from the dispatch application the radioserver is processing

at a given moment of time.

For now, only a few commands are displayed in the Server Tasks window, for example, the command to create

the radioserver event log.
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1.4.14  Map Tools

Points of Interest

The Points of Interest panel displays all the existing points of interest. You can also create, modify or delete a

point of interest from the panel.

To view points of interest (POI) to be displayed on the map, expand the Tools menu in the Main Menu bar of the

SmartPTT Dispatcher window, click Map Tools and then Points of Interest.

At that, the Points of Interest panel opens.

 In the panel window you can do the following:

· Create a new POI

· View the list of created POIs

· Hide or show POIs on the map

To create a new POI:

1. Open a map.

2. Click Create.

3. In the opened window type the name of the POI and upload its picture. Click OK.

4. Place the new POI on the map by clicking the left mouse button.

5. To save the position of the POI click Save in the panel window. To call off the changes, click Cancel.

You can also create the POI from the Map menu. For more information see Maps.

To hide or show the POI on the map, select the check box next to the POI title.

Geofences

The Geofences panel is used to create, modify and display geofence on the map. Geofences help dispatchers

keep an eye on subscribers. A dispatcher can define the area of the geofence on his or her own and attach

special rules to it.
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You can add a geofence in two ways:

1. By drawing a geofence on the map. You will learn about it in this article. 

2. By specifying coordinates of the geofence. For more information see Geofences.

To open the Geofences panel, expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher

window, click Map Tools and then Geofences. At that, the following window opens up.

To create a new geofence:

1. Open a map.

Note: Geofence creation with Map Point is not supported.

2. Click Create in the Geofences panel window.

3. In the opened dialog box type the name of the geofence and select the color. Click Create.

4. Draw the geofence on the map with the help of mouse and the keyboard. The geofence must have at least 3
points. To undo the last added point press the ESC key. You can also stop drawing the geofence by double-
clicking on the last point of the zone.

5. Click Save in the Geofences panel window.
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6. The record about the new geofence will appear in the Geofences panel.

7. You can activate the geofence in this panel by selecting the check box next to the name of the geofence and
edit it by clicking Edit. You can also change the color of the geofence. 

To call off creation of the new geofence, click Cancel. To modify the existing geofence, click Edit.

To assign a rule to the geofence, go to GPS Rules.

Routes

Route is a tool of SmartPTT that significantly extends functionality of the dispatch system, especially for

monitoring and controlling networks of highly mobile subscribers moving along the predefined route (for example,

employees of transportation companies). Its meaning radically differs from the pre-existing concept of a "Route"

as the trajectory of subscriber’s movement that, from now on, is called "Track".

The route, starting with version 7.1.0 is a polyline connecting key points of the network coverage area. Subscriber

location near the key points is identified by the specified radius of the route and can be summarized in the 

Subscriber Locations report.

To open the Routes panel, expand the Tools menu in the Main Menu bar of the SmartPTT Dispatcher window,

click Map Tools and then Routes. At that, the Routes panel opens.
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To create a new route:

1. Open the map window and click Create. At that, the New Route window opens.

2. In the field Name type the name of the new route.

3. Set the color of the new route.

4. In the Radius field enter allowed deviation from the route.

5. Click Create.

6. Go to the map window and draw the route. 

Route points are created by clicking with the left mouse button on the map area. To create the first route

point, point to the place where the route starts and left-click on it. To create next route points, point to the

appropriate place on the map and left-click on it. Route points connect sequentially drawing a new route on

the map. To undo the last added point, press Esc. 

You can stop drawing the route by double-clicking the last point of the route. 

7. To save the route, click Save in the Routes panel window. To call off the route, click Cancel. To modify

the existing route, click the Edit button .

Subscriber Location Panel

Subscriber Location panel shows the subscribers inside the selected area on the map.

To select area on the map, press CTRL and click with the left mouse button and draw the area covering

subscribers.

Note: The Subscriber Location panel will be opened automatically if it is hidden at the moment of subscriber

selection.
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Opened Subscriber Locations panel.

Click  to find the subscriber on the map.

To open the Subscriber Location panel manually, click the Tools menu in the Main Menu bar and then open

Map Tools. 

1.5  Settings
The Settings menu allows you to configure system parameters, create special rules, which will help you manage

workers, connect external third-party devices and so on:

· Database allows you to manage the system database, i.e., create new database or connect to the existing

database.

· Licenses allows you to install licenses.

· General Settings allows you to tune the dispatch console, e.g., define the PTT button behavior, enable

automatic system updates, select language, etc.

· Subscribers allows you to add, edit and delete radio subscribers. 

· Control Devices allows you to select and configure control devices to be used in SmartPTT Dispatcher, like

the mouse, touchscreen and other devices.

· Radioservers allows you to manage available radioservers, e.g., add new radioservers to be seen in the

dispatcher console, assign profiles to the available radioservers.

· Operators allows you to add operators and manage their rights.

· Statuses allows you to add statuses for radio subscribers displayed in the Subscribers Management

panel.

· Event Log allows you to manage the event log and the system messages.

· Call Windows allows you to configure Call Window parameters, e.g., specify the type of event that triggers

the window opening.

· Sound Settings allows you to configure sound settings and set up multichannel sound.
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· Records allows you to enable call recording and set up recording parameters.

· Positioning Systems allows you to configure GPS and Indoor settings.

· Telemetry allows you to configure telemetry commands to be available.

· Categories allows you to create categories.

· Dispatchers allows you to add other dispatchers and configure parameters of your own dispatcher console.

· Telephone Interconnect allows you to configure telephone settings and Telephone Subscribers allows you

to create a list of telephone subscribers.

· Job Ticket Statuses allows you to add statuses for job tickets.

· Third-Party Equipment allows you to configure Tipro settings.

· Hot Keys allows you to customize keyboard shortcuts for making calls to subscribers.

· Database Auto Backup allows you to set the SmartPTT Dispatcher database auto backup.

· Rules and Alerts allows you to set up rules based on general events.

· Positioning Rules allows you to set up rules based on GPS and Indoor data.

· Lone Worker Rules allows you to create and set up rules for lone workers.

· Subscriber Custom Properties allows you to add additional properties to be displayed in subscriber

Properties window.

· Custom Consoles allows you to create custom consoles with necessary elements.
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1.5.1  Database

To connect to the database, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher

window and click Database. At that, a configuration window for database creation opens.

Before creating a new database, connect to the database server. For this, fill in the Database server name field,

and click Connect. In case of a successful connection, you will see the following message in the Database

section: "Connection is established successfully!". If connection was not established, you will see a message

with the error description at the bottom of the window.
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Note: For the database server installed together with the SmartPTT Dispatcher application enter the name using

the format: Name of PC\SQLExpress (for example, MYCOMP\SQLExpress).

Authorization Mode – allows you to select authorization mode with the database.

SQL Server Authorization – you must have the login and password of the account which has access to the

SQL server.

Windows NT Authorization – the user who has logged into the Windows system, must be listed in the SQL

server’s list of users to make connection.

To create a new database, click Create Database. In the window that opened enter the name of the new

database and click Save.

Current database – allows you to connect to one of the created databases.

Restore Database – allows you to restore the current database using automatic backups. You can set up auto

backups of the database in Settings > Database Auto Backup.

To save the changes, click Finish. To apply the changes with the database, restart the dispatch console.

1.5.2  Licenses

To use the SmartPTT application you need to install licenses. There are licenses for basic features which allow

you to run the application and licenses for additional features, like telephone connection support, bridging, SNMP

service, etc.
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To install licenses, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Licenses. The configuration window opens from where you can load license files which define functions

available in the system.

Click Install License – the browse window will open. Specify the license file’s location and click Open. 

The license is installed, and the system licensing window displays information on the license type and scope of

functions.

After the license is installed, the Install License button will change to the Restore License button. Clicking the

Restore License button, you return to the previous license. After the Licensing window is closed, the latest

displayed in the window license will be applied.
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Note: If the radioserver and the dispatch console are installed on one and the same machine, you can install the

licenses either in SmartPTT Radioserver Configurator or in SmartPTT Dispatcher. If the radioserver and the

dispatcher console are installed on different PCs, you need to install the licenses in both applications.

1.5.3  General Settings

In the General Settings window you can configure the global settings of the SmartPTT Dispatcher application

(e.g., user interface language, automatic update, etc).

To set the settings, expand the Settings menu in the Main Menu bar and select General Settings. At that, the

following window will appear.
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Language: Allows you to change the language used in the dispatch console. After selecting a new language,

restart SmartPTT Dispatcher to apply the change.

Windows authentication: It enables Windows authentication within the dispatch console. For that, create the

operator with the name of the Windows user, or the Windows group to which the Windows user is assigned.

Note: In Windows 7, for the domain Windows user only domain Windows groups will be checked. Starting from

Windows 8, for the domain Windows user all Windows groups will be checked (whether domain or local).

If Windows authentication is selected, the dispatch console is opened under the operator's account, whose

name matches the name of the logged in Windows user, or Windows group to which this logged in Windows user

is assigned. At that, the Authorization window will be skipped and the operator's password ignored. In the

dispatch console, the button Change Operator  will be unavailable and the user will not be able to change

operator.

If Windows authentication is not selected or the operator's name does not match the name of the logged in

Windows user, or the Windows group, the Authorization window will open, and the user will need to select the

operator and type the password.

Launch the dispatch console on Windows start: Enables automatic launch of SmartPTT Dispatcher on

Windows start with the selected operator. This feature does not work if Windows authentication is selected.

Subscriber ID input method sets the input and display methods used for showing subscriber ID in the radio

subscriber Properties window: IP address or CAI + subscriber ID.

IP Address – IP address is entered and displayed in the subscriber's Properties window:  .

CAI + Subscriber ID (CAI network ID and a unique radio ID) are entered and displayed in the subscriber's

Properties window:  .

Call alert tone duration (s): Sets the duration of the call alert sound in SmartPTT Dispatcher.

Outgoing call tone: This alert tone plays after the PTT button is pressed and the operator is able to transmit on

the channel. This is to prompt the operator to begin speaking.

Ask for confirmation before closing or changing the operator: If selected, you will need to confirm before

closing SmartPTT Dispatcher, or before changing the operator. 

To enable automatic update, select the Automatic Update check box. If the check box is selected, the system

will be checking for updates on a regular basis.
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In the File path field specify the path to the ClientSetup.exe file, which you download together with SmartPTT

Software Installation Package. If a new SmartPTT version is available, when you launch SmartPTT Dispatcher (or

when you choose Check for Updates from the Help menu), the notification window will appear.

Note: After downloading the new version of the system, it is not necessary to uninstall the previous version.

1.5.4  Subscribers

In the Subscribers window, you can add, edit and delete radio subscribers. The Subscribers window allows you

to perform these actions with one radio subscriber or with several subscribers simultaneously.

To open the Subscribers window, click Settings > Subscribers.
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To add one radio subscriber, click Add, specify its properties in the Properties section on the right and click

Save.

To edit one radio subscriber, select this radio subscriber in the Subscribers list, change the required data in the

Properties tab on the right and click Save.

To delete one radio subscriber, select this radio subscriber in the Subscribers list, click Delete and click OK in

the Confirmation window that will open.

To add several radio subscribers, click Multiple adding.
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In the Radio ID field of the Properties section, input the range of the radio identifiers that are added or specify

them separated by comma. Specify other properties, common for all radio subscribers, that are added, and click

Save.

To change the properties of several radio subscribers, select the required radio subscribers in the Subscribers

tab, change theirs properties and click Save.

To delete several radio subscribers, select the required radio subscribers in the Subscribers tab, click Delete

and click OK in the Confirmation window that will open.

1.5.5  Control Devices

In the Control Devices window you can select and configure the control device to be used in SmartPTT

Dispatcher. This can be a mouse, touchscreen, keyboard or other external input device.
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To define the control device, expand the Settings menu in the Main Menu bar and select Control Devices. At

that, the following window appears.

The window is divided into three group boxes, devoted to a mouse, a touchscreen, and to external devices. 

Under Mouse and Touchsreen you can select the action that will be performed at clicking or tapping, and PTT

mode. These settings will be applied to several panels: Radio Fleet, Subscribers, Call Windows, Custom

Consoles, Emergencies. The Calls panel does not support these settings—single click is applied there.

The External Devices group box allows you to set up the following devices: 

· keyboard;

· external input USB device;
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· external input device connected via COM port.

To assign PTT to a keyboard button, click on the button  next to Keyboard PTT, and press a

keyboard button. At that, the pressed button will appear. To define the PTT mode (i.e., pressing and release),

select Hold, or Single press.

To set up the PTT button on any external input device connected via USB, select Other Input Device and choose

the required device from the list. Then, click on the blue button next to Device PTT Button and press any button

on the device.

External Device COM Port – COM port used to connect to the external PTT device.

There are two modes available for the PTT button on external devices: Hold and Single press.

To save changes, click Finish.

1.5.6  Radioservers

To connect the existing radioserver to the dispatcher console, expand the Settings menu in the Main Menu bar

and click Radioservers. The configuration window for setting up and configuring radioservers opens up.
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By default, the list of radioservers is empty. Click Add to open the window for adding radioservers.

Name – radioserver name displayed in the list of radioservers.

Address, Port – radioserver IP address and port number to connect with the dispatcher (the default radioserver

port number is 8888). Make sure that the Address and Port you enter match the Address and Port specified in

SmartPTT Radioserver Configurator.
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In this example we use port 8888.

Proxy:port – is a proxy server IP address and port number of the connection.

Fields Login and Password must be filled if authentication is enabled on the radioserver side. To enable

authentication on the radioserver side, run SmartPTT Radioserver Configurator, click Radioserver, select

Windows in the Authentication field. Currently, you can select only Windows authentication. If Windows

authentication is selected, you can't connect the dispatcher console and the radioserver without indicating valid

credentials in the Login and Password fields. If the radioserver computer makes part of a domain, indicate the

domain login and password, if not – indicate local login and password.

Note: If No is selected in the Authentication field, make sure that the fields Login and Password in the

dispatcher console are empty. Otherwise, the dispatcher console and the radioserver can't connect.

Active – if selected, the radioserver is available for connections. You should also remember that you do not have

to remove the radioserver from the list to disable it. It is enough to clear the check box.

Operator – list of all active operators created in SmartPTT Dispatcher.
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Profile Name – enter profile name defined for the dispatcher in SmartPTT Radioserver Configurator. If Profile

Name is not specified, the dispatcher has access to all radios, talkgroups and services provided by the

radioserver. If the profile name is incorrect, the radioserver will be marked red.

Note: Profile management is described in the SmartPTT Radioserver Configurator help file.

After all the fields are completed, click OK. At that, the new radioserver appears in the list of radioservers.

To edit the radioserver settings, select it in the list of radioservers and click Edit. To delete the radioserver, select

it in the list of radioservers and click Delete. To find all the running radioservers in the network, click Search. 

IPMI Settings

Intelligent Platform Management Interface (IPMI) is a standardized computer system interface used for out-of-band

management of computer systems and monitoring of their operation.

SmartPTT system uses IPMI for managing and monitoring remote radioservers. With the help of IMPI you can not

only learn about the hardware characteristics of the radioserver machine, but also turn it on/off remotely.
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To set up IPMI open the Server Settings window of the selected radioserver and then open the IPMI tab.

Address, Port – IP address and port number of the radioserver PC that are used to establish IPMI connection.

Login and Password are obligatory fields. They must match the login and password set in IPMI configuration

settings on the radioserver PC.

Authentication – authentication types. Use MD5 as default authentication type.

Privilege – depending on the privilege used, the user has different permissions. Use Administrative as default.

For more information about the privileges, check the official IPMI documentation.

Ciphers – the list of ciphers to be used. Select the default cipher, that is RAKP-HMAC-SHA1, HMAC-SHA1-96,

AES-CBC-128.

Active – select the check box to activate IPMI functionality for the radioserver.

Note: For more information about managing the radioserver with the help of IPMI, see Monitoring.
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1.5.7  Operators

By default, an operator with the name Administrator and no password is created in SmartPTT Dispatcher. The

Administrator has full access to SmartPTT management functions.

The Administrator can add new system operators and customize their access to specific functionality.

To add a new operator, click Settings > Operators in the Main Menu bar. At that, the Operators window will be

displayed.
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To add a new operator, click Add. A new window for adding operators opens up.

Name: The operator’s name. If Windows authentication is selected (Settings > General Settings), make sure

that the new operator's name matches the name of a Windows user or Windows group.

Status: The operator’s status (“Active” or "Archived"). Status in the archive is used for registered operators which

are not used any longer, but cannot be removed from the system as the event log contains entries referring to

them.

Rights: A list of permissions which can be selected or cleared for each operator individually. The following rights

can be assigned to the operator:

Right Description

Add/Delete subscriber units allows/denies adding, changing properties and deleting

radio subscriber in the Radio Fleet window and in the

Subscribers panel

Manage unregistered subscriber units shows/hides subscribers which were not added in the 

Radio Fleet window or in the Subscribers panel
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Right Description

Make voice calls allows/denies making calls to radio subscriber except

conference calls

Note: This option does not have visual effect in SmartPTT

Dispatcher

Connect with external dispatcher allows/denies the connection of the dispatchers to each

other

Note: Requires preliminary configuration in the each

dispatch program

Make telephone calls allows/denies making call to the telephone subscriber

Change channel on control station allows/denies changing the channel of control station

Block/Unblock radio allows blocking/unblocking subscribers listed in the Radio

Fleet window

Radio Kill allows to block a radio irreversibly by means of the Radio

Kill command

Remote monitor allows/denies the remote monitoring of radio subscriber

(remote turning on the microphone of the radio unit)

Note: Permission must be configured on the radio

subscriber unit

Reboot control station allows/denies rebooting the control station

Manage subscriber location settings enables/disables configuring regular requests for radio

subscriber location in the Location tab

Request subscriber location allows/denies requesting and deleting current location of

the radio subscriber:

Set Location Find on Map 

Show Address Remove from Map 

Send text message allows/denies sending text messages to the subscriber

Send telemetry commands allows/denies sending telemetry commands
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Right Description

Manage bridging settings enables/disables configuring call bridging table

Manage routes enables/disables managing routes

Manage geofences enables/disables managing geofences

Manage points of interest enables/disables managing points of interest

Manage tracks enables/disables showing, animating, and clearing tracks

View coverage map enables/disables showing and configuring coverage map

Build reports allows/denies managing reports

Edit custom subscriber properties enables/disables configuring additional properties of the

subscriber

Attach radios to selected channel enables/disables displaying subscribers as attached to

the particular slot in Radio Fleet window. This option is

recommended to be set for Capacity Plus systems

Make conference calls enables/disables making conference calls

View radioserver event log enables/disables showing radioserver event log

Create deferred action enables/disables creating deferred actions for subscriber

Manage statuses enables/disables creating, editing and deleting statuses;

Manage rules and alerts allows/denies creating, editing and deleting rules and

alerts

Manage positioning rules allows/denies managing positioning rules

Manage lone worker rules allows/denies managing lone worker rules

Set/Change Password: Sets new operator's password or changes the old one.

To edit an operator, select it in the list of operators and click Edit. The edit window is displayed where you can

change Name, Status and Password parameters.

To delete an operator from the operators list, select it and click Delete.

Note: You cannot delete the Administrator from the system.
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To switch operators, click  in the Main Menu and after the dispatch console has restarted, select a new

operator.

1.5.8  Statuses

You can create statuses to assign to radio subscribers (for example, Available, On Call, In Place or Busy). Each

radio subscriber can have a status showing their current state. The status is set either by the dispatcher or by the

radio subscribers themselves.

To set up statuses, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Statuses. At that, the configuration window opens.
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To add a new status, click Add in the Active tab. A window for adding a new status opens.

Name – status name to be displayed in SmartPTT Dispatcher.

Color – status color to be displayed in SmartPTT Dispatcher.

System Message – message which triggers status change, that is if a radio subscriber sends this message to

the dispatcher, the subscriber receives the status.

Sound – audio file played back if the status is activated.

Click OK, and the new status is added to the list of statuses.

To edit the existing status, select it in the list of active statuses (the Active tab) and click Edit.
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To delete the status, select it in the list of active statuses and click Delete. You can delete a status only if it was

never assigned to a subscriber. If the status is currently assigned to a subscriber or used to be assigned, it can't

be deleted. But, it can be moved to an archive. Characteristics of the archive statuses are:

· They can't be assigned to radio subscribers.

· They can't be used in the alert rule definitions. However, the archive status remains valid as an alert rule

criteria for a particular rule, if it was selected as such before being moved to the archive.

· They are displayed in the event log entries.

· They can be restored from the archive.

To see the list of archive statuses, open the Archive tab of the Statuses window.

To move the status to the archive, select the status from the active status list, click Delete and click OK in the

opened dialog box to confirm the action.
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In order to restore the status from the archive, select the status from the archive list, click Restore and then click

OK in the opened dialog box to confirm the action.

1.5.9  Events and Notifications

The “Events and Notifications” window provides the following settings:

· Event log settings,

· Settings for the Emergencies panel,

· System message settings.

To open “Events and Notifications” window on the Settings menu  click Events and Notifications. The

Configuration window appears. You can switch between tabs here to configure the event processing in the

system.
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Event Log
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The following settings are available to you:

· Save Events to Log: Select to make records on the event in the SmartPTT Dispatcher database.

· Maximum number of records to be shown: Enter the maximum number of the latest events you want

to see in the Event Log.

· Event Log Parameters: Configure the deletion of records from the Dispatcher database:

o Do not truncate: Click to add new records to the database until it reaches it maximum space on the

hard drive.

o Records retention period (days): Click to delete records which older that particular number of days.

Enter the number of days in the field next to this option.

· Show time with milliseconds: Select to show milliseconds in the Event Log.

Notification Panels

The following settings are available to you:

· Emergencies: Configure the emergency situation processing:

o Notify dispatcher about emergency: Select to open the Emergencies panel automatically and/or

show the subscriber on the map if Maps are opened.

o Category for Emergencies: Click Browse  to select the category (only one) of emergency

situations (see Categories).

o Play Sound File: Click Browse  to select the audio file, which should be played at the emergency

situation.
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Note: The Emergencies panel appears only when emergency signal is registered. You cannot open it

manually.

· Latest incoming calls: Configure the latest calls processing:

o Remember the latest incoming calls: Select to make records about the latest incoming calls (see

Latest Incoming Calls).

o Number of the latest calls: Enter the maximum number of records about the latest incoming calls.

System Messages

The following settings are available to you:

· Network events: Configure network events processing:

o Errors: Select to show error messages in the System messages panel.

o Warnings: Select to show warning messages in the System messages panel.

o Information Messages: Select to show information messages in the System messages panel.

Note: If you unselect Errors, you will get error messages in separate windows instead of that in the System

messages panel.
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· Hardware events: Configure hardware events processing (works only if Monitoring is active):

o Critical problems: Select to show errors in the System messages panel.

o Non-critical problems: Select to show warnings in the System messages panel.

· Play Sound File: Click Browse  to select the audio file, which should be played when system

messages appears.

To save changes and close the window, click Finish. To cancel changes and close the window, click Cancel.

Emergencies

The “Emergencies” panel appears in SmartPTT Dispatcher when subscriber sends an emergency alarm.

Operator can make the following actions:

· Call the talkgroup which is preconfigured in the radio via the MOTOTRBO CPS program. To start the call it

should click PTT.

· Mute the emergency alarm by clicking Mute  .

· Report about the solution found for the situation. When operator clicks Close Emergency  , the panel

closes. However, the emergency mode of the radio stops only when subscriber turns it off on the radio.
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1.5.10  Call Windows

To configure the parameters of the Call Window, expand the Settings menu in the Main Menu bar of the

SmartPTT Dispatcher window and click Call Windows. At that, the configuration window opens where you can

configure the appearance and functions of the Call Window.

Call Window Closing Timeout (s) — sets the time period in seconds at the end of which the Call Window

closes automatically.

Note: If you enter 0 in the field, the Call Window won't close automatically.

Open Call Window for Event Types — specifies types of events triggering the Call Window opening

(Registration, Call, Message, Telemetry, Alarm, Status, Block Radio, Job ticket, Radio Check).
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Maximum Number of Opened Call Windows — allows you to set up the maximum number of call windows

opened automatically.

Show Photo in Call Window — select to display the subscriber's photo in the Call Window.

Show Pinned Call Windows on Console Launch — if selected, the position of the Call Windows, pinned

before the SmartPTT Dispatcher application closing, will be restored during next launch.

Set Focus to Call Window upon Popup — select the check box to focus on the Call Window when it is

opened or have a new activity.

Reset Saved Call Window Positioning — click the button to reset the current position of the call windows.

1.5.11  Sound

Warning! For proper operation, make sure that you have a working microphone. If not, you won't be

able to make or answer calls.

To set audio device settings and VoIP parameters, expand the Settings menu in the Main Menu bar of the

SmartPTT Dispatcher window and click Sound Settings. At that, the configuration window opens up.

The Sound Settings window includes:

1. General Settings tab

2. Audio Output Devices tab

3. Other Settings tab
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The General Settings tab:

Audio Input parameters:

Device – audio device to which the microphone is connected. It is recommended to select the audio input device

explicitly.

Input Line – audio mixer line used to connect a microphone.

Noise Reduction – allows making dispatcher sound clearer by reducing noises. You can choose several levels

starting from 3 to 18 dB. If voice and noise levels are the same or close, do not enable noise reduction.

Audio Input Test – allows checking quality of microphone performance. To test your microphone performance,

click Record and then talk into the microphone. Stop recording by clicking Stop, which appears instead of
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Record. To listen to what you have just recorded, click Play. You can also save the recording in MP3 format by

clicking Save. 

Audio Output parameters:

Device – audio device to which headsets or speakers are connected. To check quality of the audio output device

performance, click Check. At that, you will hear a sound. To stop the sound, click Stop.

VoIP Parameters:

Codec – audio stream compression method.

Codec Format – audio stream sampling frequency.

VoIP Port – audio stream receive port.

Specifications of the codec format 8000 Hz, 20 ms, 64 (86) kbps:

8000 Hz – the sampling rate

20 ms – the frame size

64 kbps – the voice data bit rate

86 kbps – a full bit rate (required network bandwidth)
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Starting from version 8.3, dispatch console allows you to set up different audio output devices, including multiple

channels, for different subscribers, talkgroups, slots, etc. e. g., you can listen to radio subscribers on the

headset, and the external dispatcher on the speakers. To do that, open the Audio Output Devices tab.
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1. Add audio output devices in the first box on the left. These are not real output devices and are used only

in dispatch console. To do that click on Add. A new record will appear on the list. Change its name, if

necessary, by clicking Edit, and then select it.

2. In the list below, select the real devices or device channels which will correspond to the added output

device.
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3. In the Objects list select the network object, for which you want to set up the new audio device or

channel. And in the Select Audio Output Device dropdown list select the created output device. Thus,

you assign the audio output device or channel to a network object.
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To assign another device to an object, you can do it in its Action List in the Subscriber Panels.

The Objects section contains also the following categories of objects that may use personal audio output:

Selected objects: selected radio objects or radio objects with opened call window, including call windows of

telephone calls, dispatchers calls and conferences. The volume of the selected objects is adjusted on the Sound

panel.

Unselected objects: unselected radio objects with inactive call windows. The volume of the selected objects is

adjusted on the Sound panel.

System sounds: outgoing call tone, play sounds alerts for incoming calls from dispatchers and telephone

subscribers, play sounds when the rule is triggered, record from the event log, sound of the system message, call

alert. The volume of the system sounds is adjusted on the Sound panel.

Alarm: emergency sound and voice of emergency call. The volume of emergency sound cannot be adjusted and

muted. The volume of voice of emergency call can be adjusted in the Properties window of a slot in the Common

tab (it is also possible to mute the volume of a slot and/or talkgroup).

Selected objects, Unselected objects and System sounds always have the Main Device audio output assigned

by default. The Alarm object does not have any audio output device assigned by default.

Note: If the Alarm object does not have any assigned audio output device, in a case of alarm situation sound

of the Alarm object will be played back on the audio device of either the selected objects or unselected

objects (it depends on whether the object which sends the alarm signal is selected or not).

Thus, sound of the radio fleet object can be played back on the following audio devices:
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· Audio device assigned to Selected objects, if the object is selected.

· Audio device assigned to Unselected objects, if the object is unselected.

· Personal audio device assigned to the particular radio fleet object.

· Parent audio device, i.e. the audio device assigned to a parent object.

· Audio device assigned to the Alarm object, if there is an alarm signal (emergency sound, voice of

emergency call).

If the Use the personal audio output only check box is selected, the assigned audio output will be used only

by this object independently of any conditions. The Use the personal audio output only option disables audio

playback of the given object on the audio devices assigned to parent object and Selected objects/Unselected

objects.
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To reset all settings of audio output devices, click Clear All.

The Other Settings tab allows the operator to improve receiving and transmitting the sound:

Disable complete sound muting allows/denies muting in SmartPTT Dispatcher. The minimal sound level is

10% (left position of the slider control) and the maximum is 90%. This setting effects only on SmartPTT

Dispatcher and depends on the sound level in your operating system.

Mute Mode provides options for the muted station (setting Mute  is active in the action list for the control

station):

In Basic mode all sounds from this control station will be muted,

In Advanced mode muting will not be applied for incoming private calls, dispatcher-initiated calls and dispatcher-

answered calls.
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Increase Dispatcher Sound allows/denies amplifying the voice of the dispatcher on subscriber unit. It can be

adjusted by the slider control.

Listen calls of other dispatchers allows muting other dispatchers:

Disable listening calls of other dispatchers activates/deactivates muting other dispatchers,

For all dispatchers mutes voices of all dispatchers connected to radioserver,

Specify dispatcher's location mutes dispatchers who entered the same location name into the text field.

Location is to be one-line text containing up to 50 symbols including unprintable signs.
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1.5.12  Records

To set audio record settings, expand the Settings menu in the Main Menu of the SmartPTT Dispatcher window

and click Records. The Audio Record Settings window opens.

· Records: Set the parameters of call recording.

o Record calls: Select this option to record all the incoming and outgoing calls.

o Audio records folder: Set the path to the folder with recorded audio files.

o Audio file extension: Select the proper extension of the file. Choose between the MP3, OGG and WAV

extensions



141Settings

Dispatcher User GuideSmartPTT PLUS 9.1

o Fixed sample rate (8 kHz): Select this option to set the record quality of the audio file with a sampling

rate of 8 kHz. This setting allows you to reduce the size of the saved audio file due to no major loss in

sound quality.

o Recording volume of outgoing calls: Increase or decrease the sound volume for recording outgoing

calls.

· Audio files search paths: Set paths to additional folders for recorded audio files.

Note: After changing the path to the stored audio files, the previous path is automatically added to the audio files

search path field.

· Audio records cleanup settings: Set audio record cleaning parameters.

o Do not delete audio records: Select to keep as much of events in the log as possible in the hard drive.

o Records retention period (days): Select to enter the maximum number of the last days to be logged.
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1.5.13  Positioning Systems

To define GPS or Indoor settings, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher

window and click Positioning Systems. The Positioning Systems window will open.

The Coordinates tab contains the following parameters.

Validity of GPS coordinates: The parameter sets GPS data validity period in minutes. If new GPS coordinates

were not received during this period, the subscriber's label is removed from the map.

Validity of beacon signals: The parameter defines the time period during which the received beacon signal is

relevant. If new beacon signals were not received during this period, the subscriber's label is removed from the

building plan.
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Time interval for GPS coordinates update: It sets the default time interval for updating radio's location data.

The value set in this parameter will be applied to all unregistered radio subscribers, and will be displayed in the 

Properties window of a radio subscriber in the Location tab.

Accuracy Radius: It sets the maximum coordinate error margin. If the received error value exceeds the value

specified in this field, the coordinate is invalid.

Color of Subscriber with Valid GPS Location: It sets the color which will be used for a radio subscriber's label

with valid GPS locations.

Address Data Provider: It defines the map service (Google or OpenStreetMap), which will determine the object

address on the map corresponding to the subscriber's current GPS-coordinates.

Data Format: It defines the format of location data to display in the subscriber Call window:

Coordinates: It allows you to select the format of GPS coordinates:

· Decimal degrees. GPS coordinates are displayed as: lat: 56,47568, long:84,98779.

· Degrees, Minutes, Seconds. GPS coordinates are displayed as: lat: 56°28'32", long:84°59'16".

· Universal Transverse Mercator Coordinate System. GPS coordinates are displayed as: 45V 376108 B
6260913 C.

Speed Format: It allows you to select the format of a radio subscriber's speed.

System of Units: It allows you to select the measurement system (Metric or Imperial).

Note: When changing measurement system, the data previously logged won't be recalculated according to the

new measurement system.

Save GPS Locations in Database: It defines if GPS coordinates received from subscribers will be stored in the

database.

Database cleanup settings: It defines the scheme of deleting coordinates from the database.

The Map tab contains the following parameters.

Show Subscriber’s Information for Map Label: It defines what information will be shown on a map label of a

radio subscriber.

Size of Subscriber’s Map Label: It sets the size of a subscriber's map label.

Hide subscribers with outdated locations: Select the check box to hide map labels for subscribers with

outdated GPS locations. GPS location becomes outdated if it was not updated during the period set in the 

Validity of GPS coordinates field.
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Hide offline subscribers: Select the check box to hide a map label when a subscriber goes offline.

1.5.14  Telemetry

To set up actions based on incoming/outgoing telemetry commands, expand the Settings menu in the Main

Menu bar of the SmartPTT Dispatcher window and click Telemetry. At that, a configuration window is displayed.
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To add a new telemetry command, click Add. The Telemetry Settings window is displayed.

Description – description of the action to be triggered.

Contact – select a contact or VIO from the list.

Note: Make sure the selected contact or VIO is mapped to a physical GPIO line in MOTOTRBO CPS.

Direction – select direction (incoming or outgoing).

Action – action type: impulse, high level, low level, toggle level.

To save the changes click OK – the created settings appear in the list of settings.

To edit the existing settings, select the entry in the list of settings and click Edit.

To delete the settings, select the entry in the list of settings and click Delete.

How to Assign Telemetry to the Radio Subscriber

You can select telemetry settings in the subscriber's Properties window.

Note: Only registered subscribers can be assigned to a telemetry command. For not registered subscribers the

Telemetry button will be unavailable.
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Click the Telemetry button to open the window for selecting available telemetry commands for the subscriber.

Select the required command to make it available in the Call Window of the radio subscriber and in the custom

consoles. Also, it allows you to set automatic status updates of the GPIO pins. To receive status updates of the

GPIO pins automatically, select the required GPIO pins in the Update GPIO pins' status area and set the update

interval in seconds.

Note: Automatic GPIO pins' status update is applied only for incoming telemetry commands.

Then you can run the telemetry command from the subscriber's Call Window.
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To receive the current telemetry status, click . The updated status will be displayed in Call Window of the

radio subscriber.
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How to Assign Telemetry to the Talkgroup of Radio Subscribers

You can select telemetry settings in the Properties window of the talkgroup. 
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Click the Telemetry button and select available telemetry commands for the talkgroup.

Then you can run the telemetry command from the talkgroup's Call Window.
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1.5.15  Categories

To create a category structure, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher

window and click Categories. The configuration window for setting up the category structure opens.
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Show "No Category" Folder – displays a list of all online subscribers (radio subscribers, talkgroups) in the No

Category folder of the Radio Fleet panel (filter by category), without reference to categories.

To create a new category, click Add in the Categories window.
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To edit the existing category name, select it in the list and click Edit. To remove a category, select it in the list

and click Delete.

To move categories inside a parent category, use arrow button on the right. To move the categories between

levels, click on a category, hold the left mouse button and drag it to a new position.

The categories are displayed in the Radio Fleet panel (filter by category  is selected).
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Click the button  next to the category name to apply actions to all the subscribers from the category.

Send Message – opens the window for sending messages.

Show on Map – displays all subscribers from this category on the map, if it is opened.

Remove from Map – removes all subscribers of this category from the map, if it is opened.

View Properties – opens the window of properties of the category. Also you can right-click on the category name

in order to open this window.
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The Category window consists of three tabs: Common, Subscribers, Talkgroups.

The Common tab:

Name – the category name.

Status – the general status of all subscribers in the category. If the status of at least one subscriber in the

category is changed, the category's general status becomes undefined.

Update location – the group of the general GPS-monitoring settings of all subscribers in the category. The

parameters of the general GPS-monitoring settings can have three possible states:

– Checked . Shows that the parameter is set for all subscribers in the category.

– Unchecked . Shows that the parameter is not set for all subscribers in the category.

– Mixed choice . Shows that the parameter is set for some subscribers in the category.

The parameters of the general GPS-monitoring settings are unavailable, if all subscribers in the category have

GPS disabled in the Properties window (the Locations tab).

The Subscribers tab contains the list of all subscribers in the system. In order to assign a subscriber to the

category, select the appropriate check box in the list of subscribers. Only registered subscribers can be assigned

to a category. Not registered subscribers will be in italics on this list, and you won't be able to select them.

The Talkgroups tab contains the list of all talkgroups in the system. In order to assign a group to the category,

select the appropriate check box in the list of talkgroups.

Note: Radio subscribers and talkgroups  can be assigned to a category. However, the actions applied to the

category members will be addressed only to radio subscribers.

1.5.16  Dispatchers

SmartPTT Dispatcher allows you to connect to other dispatchers who use the SmartPTT system. But before

connecting to other dispatchers you must check or do the following:

1. Make sure that the operator has the permission Connect with external dispatchers (Settings >

Operators). If not, the Dispatchers button   will be unavailable in the Main Menu, and calls to other

dispatchers will be impossible. 
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2. Make sure that at least one dispatcher is added to the dispatchers list in Settings > Dispatchers. If the list

is empty, the Dispatchers button   will be unavailable in the Main Menu even if the permission

Connect with external dispatchers is selected.

To set up connection to other dispatchers, expand the Settings menu in the Main Menu bar and click

Dispatchers.

VoIP Port —  UDP port of this dispatcher's PC for voice transmission. The default value is 18501.

Session Port – TCP port of this dispatcher's PC for transmission of commands and text messages.  The default

value is 18501.

Play Sound Alert for Incoming Call – select this check box to play a tone for an incoming call.

Play Sound Alert for Outgoing Call – select this check box to play a tone for an outgoing call.
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To add a new dispatcher, click Add.

Name – the dispatcher’s name displayed in the list of dispatchers.

Address – IP address of the dispatcher's workstation (DNS name can be used).

VoIP Port – UDP port for voice transmission.

Session Port – TCP port for transmission of commands and text messages.

Select – the path to the file of the dispatcher's photo.

Sound for Incoming Call Alert – the path to the sound file which will play in the dispatch console when this

dispatcher calls.

To save the changes, click OK. At that, a new dispatcher is added to the list of dispatchers.

To edit dispatcher settings, select it in the list of dispatchers and click Edit.

To remove a dispatcher, select it in the list of dispatchers and click Delete.



158Settings

Dispatcher User GuideSmartPTT PLUS 9.1

To call the dispatcher, open the Dispatchers window by clicking the button  . At that, the following window

opens.

On the left you can see available dispatchers with different statuses. These can be:

Offline – the dispatcher is not available for communication. This means that the dispatcher has not launched

SmartPTT Dispatcher, or does not have the permission (Connect with external dispatchers).

Online – the dispatcher is available for communication.

Ringing – calling to the dispatcher to establish voice communication.

Call – voice communication is established.

To call a dispatcher, select it from the list, and click Connect. To end the call, click Disconnect (this button

appears as soon as you have started communication).

To add online dispatchers to a conference call, click .

To mute your voice transmission, click . You will still hear the other dispatcher. This button becomes

available when the call is started.

To send a message to the selected dispatcher, enter the text of the message and click .
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To answer or decline the incoming call from a dispatcher, click Accept or Decline in the opened window:

If the incoming call is made by the dispatcher not on the list you will see its IP address in the Incoming call

window. You can add the unregistered dispatcher in the Dispatcher window by clicking on the Add button.
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1.5.17  Telephone Subscribers

To view the list of registered telephone subscriber, expand the Settings menu in the Main Menu and click

Telephone Subscribers. The list includes all telephone subscribers that support SIP connection. You can

modify and delete existing subscribers, or add new subscribers.



161Settings

Dispatcher User GuideSmartPTT PLUS 9.1

Note: SIP connection can be established also with telephone subscribers not added to the list. To make an

outgoing call, you can use a dial pad.
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To add a telephone subscriber to the list of subscribers, click Add. At that, the following window opens.

Subscriber – type the name of telephone subscriber.

The SIP Address area allows you to specify the telephone subscriber address.

There are several options to enter the address of the subscriber. First, the outgoing and incoming address fields

can be generated automatically using the default gateway settings. To do that, click Automatic. 

Second, you can enter the addresses manually by clicking Full Address (use the following format – sip:prefix

number@gateway:port).

Select the Enable SIP Account check box and specify the required SIP account from the list of available to carry

out SIP connection under the set account. For SIP account setup details in SmartPTT Dispatcher see SIP

Accounts.

Sound for Incoming Call Alert – the path to the sound file which will play in the dispatch console when this

telephone subscriber calls.

Click OK to save the changes.

As soon as you have added a new telephone subscriber, it appears in the Telephone Subscribers window.

Please remember that the Allow Calls to Telephone Subscribers check box in the Telephone Interconnect

window must be selected.

To edit or delete the telephone subscriber from the list, click the corresponding button.
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1.5.18  Telephone Interconnect

SmartPTT Dispatcher has a built-in function to make telephone connections with telephone subscribers. A call

can be initiated both by the dispatcher and the telephone subscriber. Standard VoIP gateways are used to

connect to telephone subscribers. The following connection options are possible:

1. The dispatcher calls the office PBX subscriber and voice is transmitted in full-duplex mode.

2. The office PBX subscriber calls the dispatcher and voice is transmitted in full-duplex mode.

3. SmartPTT Dispatcher connects telephone and radio subscribers.

Connection and subscriber addressing are implemented via SIP protocol. Voice data is transmitted via RTP

protocol.

The connection scheme:

A VoIP gateway is a device which bridge conventional telephone networks and equipment to VoIP telephone

networks.

A Private Branch eXchange (PBX) is a telephone exchange that serves a particular business or office.
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The Public Switched Telephone Network (PSTN) is the network of the world's public circuit-switched telephone

networks. 

SIP Architecture

Call service management is distributed between different elements of SIP network. The basic functional unit that

implements connection management are User Agents, which are endpoints of a call (that is each of the

participants in a call). The remaining network elements (SIP-servers) are responsible for call routing and can

provide additional services. 

1. User Agents

User agents are both the computer that is being used to make a call, and the target computer that is being called.

These make the two endpoints of the communication session. There are two components to a user agent: a client

and a server. When a user agent makes a request (such as initiating a session), it is the User Agent Client

(UAC), and the user agent responding to the request is the User Agent Server (UAS). Even though other devices

that we’ll discuss are optional to various degrees, User Agents must exist for a SIP session to be established.

2. Proxy Server

Proxy servers are computers that are used to forward requests on behalf of other computers. If a SIP server

receives a request from a client, it can forward the request onto another SIP server on the network. While

functioning as a proxy server, the SIP server can provide such functions as network access control, security,

authentication, and authorization.

3. Registrar Server

Registrar servers are used to register the location of a user agent who has logged onto the network. It obtains the

IP address of the user and associates it with their user name on the system. This creates a directory of all those

who are currently logged onto the network, and where they are located. When someone wishes to establish a

session with one of these users, the Registrar server’s information is referred to, thereby identifying the IP

addresses of those involved in the session.

4. Redirect Server

The Redirect servers are used by SIP to redirect clients to the user agent they are attempting to contact. If a user

agent makes a request, the Redirect server can respond with the IP address of the user agent being contacted.

This is different from a Proxy server, which forwards the request on your behalf, as the Redirect server essentially

tells you to contact them yourself. 
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SIP determines the following addressing system: [sip:] id [@ fragment]. ID indicates user name or phone number

of the subscriber. Fragment specifies the host, which can be set to the domain name, the IP-address of the

computer or the address of the VoIP gateway. Caller ID can be presented in different ways, such as 

user_name@[domain name], name@[IPaddress], phone_number@[VoIPgateway].

SIP Connection Methods

There are two SIP connection types – SIP trunking and using a SIP account.

SIP trunking is used when a user agent (SmartPTT Dispatcher in our case) has a static IP address. This IP

address must be prescribed on SIP server only once, and the client does not require to re-register on the SIP

server. SIP trunking provides security by means of password authentication for incoming and outgoing calls.

If the client IP address changes periodically, use a SIP server account to establish the connection. When the

client turns on, it sends a special package for SIP registration to the server. The package contains authentication

data (SIP account user name, login, password) and the current IP address. Since then server knows where to

route calls addressed to the client. After a period of time the client automatically updates the registration. If its IP

address has changed, SIP server accordingly updates the information on this user.
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Telephone Interconnect Configuration

To configure connection parameters with telephone subscribers, expand the Settings menu in the Main Menu

bar of the SmartPTT Dispatcher window and click Telephone Interconnect.

The Telephone Interconnect window includes:

1. General settings

2. Codec settings

3. SIP Trunk Authentication

4. SIP accounts

General Settings

The General Settings tab includes Dispatcher Settings and VoIP Gateway Default Settings sections. 
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1. Dispatcher Settings

Allow Calls to Telephone Subscribers – select the check box to be able to make and receive calls between

SmartPTT Dispatcher and telephone subscribers. 

Note: If the check box is not selected, the Telephone Subscribers window is unavailable.  

RTP Ports – each connection with the telephone subscriber requires two UDP ports (even port numbers are used

by RTP protocol, uneven – by RTCP). Thus, the specified ports must be available both for incoming and outgoing

traffic. The default port range is 18700–18748.

Warning! If both SmartPTT Dispatcher and SmartPTT Radioserver are installed on one computer, the

port range set in the "RTP Ports" field in SmartPTT Dispatcher must differ from the port range set in the

"RTP ports" field in SmartPTT Radioserver Configurator. 

Interface – IP address of the local computer, used to receive and transmit commands and voice data. If the

dispatcher's computer has only one IP address, the system can select it automatically; if it has more than one IP

address, the IP address (interface) should be specified expressly. The specified IP must be available from the

VoIP gateway end.

Warning! If several network interfaces are installed on the computer you may have to configure the

routing table using the command "route add ...".

SIP Port – UDP or TCP port number to receive and send SIP data packets. The default value is 5060.

Accordingly, the specified port must be available for incoming and outgoing traffic.

Warning! If both SmartPTT Dispatcher and SmartPTT Radioserver are installed on one computer, their

SIP ports must differ. In this example it must be 5061 because 5060 is already taken by the radioserver.

Displayed Telephone Number – type the telephone number which allows you to connect to SmartPTT

Dispatcher. This number is also displayed on the screen of the receiving SIP call device (phone or softphone).

Subscriber Name – type the name to be displayed on the screen of the receiving SIP call device (phone or

softphone).
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2. VoIP Gateway Default Settings

If VoIP Gateway Default Settings are specified, it is enough to set only subscriber phone numbers in the List of

Subscribers tab. Also, these parameters are used to dial the called subscriber number manually (click the  Dial

Pad button and the Dial Pad window opens).

Default VoIP Gateway Address – the VoIP gateway IP address.

SIP Port – a VoIP gateway to receive and send SIP data packets. By default VoIP gateways use the UDP port

5060.

Dial Prefix for Outgoing Calls – numeric prefix added to the called subscriber number by SmartPTT Dispatcher.

VoIP gateway uses the prefix to determine where the call came from and what rules it must apply to the call

(block or allow, where the call must be routed).

Dial Prefix for Incoming Calls – numeric prefix value in this field must match the same VoIP gateway prefix. 

If default VoIP gateway is used, the telephone subscriber's complete SIP address will be as follows:

SIP address = Dial Prefix for Outgoing Calls + Phone Number + @ + Default VoIP Gateway Address + : +

Gateway SIP Port.

 Example:

 If the following settings are used:

 Default VoIP Gateway Address = 192.168.0.243

 SIP Port = 5060

 Dial Prefix for Outgoing Calls = 12

 The telephone subscriber with the phone number 1140 is automatically assigned the following outgoing SIP

address = 121140@192.168.0.243:5060.

Note: If your network uses a firewall, consult a network administrator about the possibility of using SIP protocol

and the required settings. The most common problem is that the media streams (for example, voice) are

transferred over dynamically assigned UDP ports that are generally closed. The firewall must be able to

dynamically open and close ports based on the transferred SIP signaling. Another problem is that the SIP clients

inside the firewall cannot be reached by IP addresses since these most often are private and local to the LAN.

Communication simply does not take place, unless there is specific SIP support in the firewall.

Play Sound Alert for Incoming Call – select the check box to enable ringing at the SmartPTT Dispatcher

application when a telephone subscriber calls.
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Play Sound Alert for Outgoing Call – select the check box to enable ringing at the SmartPTT Dispatcher

application when making a call to a telephone subscriber.

Sound Level – allows you to configure the sound level in the dispatch console coming from the telephone

subscriber.

3. VoIP Gateway Configuration

The VoIP gateway administrator must ensure that SIP addresses for incoming calls are appropriately interpreted

and switched to phone numbers.

In the example above the telephone subscriber address is sip:121140@192.168.0.243:5060 and the dial prefix for

outgoing calls is 12. Therefore VoIP gateway rules must discard the incoming prefix 12 from the full address and

connect the dispatcher to the telephone subscriber number, that is 1140.

You should also configure appropriate generation rules for outgoing SIP addresses to call other dispatchers.

For example, if the telephone subscriber with the number 1140 assigned wants to connect to the dispatcher with

the address 192.168.0.105:5060, then generation rules for outgoing SIP addresses on the VoIP gateway must

generate the correct destination address sip:1@192.168.0.105:5060 (the Displayed Telephone Number value

must be set as the SmartPTT Dispatcher identifier) and the sender's correct address

sip:1140@192.168.0.243:5060 (a dial prefix for incoming addresses is not set so the name in the sender's

address is the same as the phone number).

Codec Settings

In the Codec Settings tab you can enable or disable supported audio codecs, as well as change their priorities.

Currently, there are 4 audio codecs: G711A, G711Q, SPEEX и G729.
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SIP Trunking Authentication

The Telephone Interconnect window contains authentication settings in a separate tab.

Incoming Call Authentication – the setting includes parameters required for incoming call authentication. When

an incoming call from a phone/softphone is received, dispatcher asks user name and password corresponding to 

Realm in the described setting. Calling subscriber must send back user name and password specified in this

setting. The authentication type is not required if the incoming call is addressed to subscriber using SIP account

for connection. To activate this ability, select the Enabled check box.

Realm – parameter used for the incoming telephone calls authentication.

User Name – name of the user used for authentication.

Password – password used for authentication.
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Outgoing Call Authentication – the setting includes parameters required for outgoing call authentication.

Realm – if not set, SmartPTT Dispatcher responds to any any authentication request with specified user name

and password. If set, SmartPTT Dispatcher responds only to authentication requests that matches the Realm

value. 

User Name – user name used for authentication.

Password – password used for authentication.

SIP Accounts

If SmartPTT Dispatcher IP address varies, there must be a mechanism for determining its current value. In order to

do this, SIP registration can be used, allowing the dispatcher to inform SIP server of its actual IP address. 

For example, Client 1 has current IP address 192.168.0.224, Client 2 – 192.168.0.98. It is necessary to establish

connection between them, while both subscribers are not aware of each other's IP addresses. To do this, create

accounts on SIP server (sip_server.com) for both subscribers – user1 (sip: user1@sip_server.com) and user2

(sip: user2@sip_server.com) respectively. SIP server stores current IP addresses relevant to the SIP accounts of

Client 1 and Client 2. Therefore, Client 1 is not required to know current IP address of Client 2 to make a call.

Client 1 refers to the SIP server under its account and requests connection with Client 2 pointing out its SIP

account. The SIP server searches its database for the current IP address of Client 2, returns it to Client 1 or

redirects the call from Client 1 to Client 2.

The SIP Accounts tab in the Telephone Settings window contains dispatcher SIP account parameters. These

accounts are created by the dispatcher on various SIP servers in advance. The parameters are used to establish

connection with other server subscribers.

The Status field displays the account registration status on SIP server. Possible values – Registered, Not

registered, Processing, and SIP error messages.
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To add a record about a new SIP account, click Add. At that, the following window opens.

Active – select this check box to enable account registration on SIP server.

Display Name – the name that appears on the subscriber device screen.

Username – the account identifier on the SIP server. 

SIP server – remote SIP server IP address.

Proxy – proxy server which can be used for special cases (for example, some providers insist on using proxy to

request SIP server).

Domain – parameter for SIP server account authentication.

Login – login for SIP server account authentication.

Password – password for SIP server account authentication.

Registration Renewal Timer – time period (in seconds) between requests for the dispatcher IP address update

on the SIP server.



173Settings

Dispatcher User GuideSmartPTT PLUS 9.1

 The following example is focused on setting up connection between SmartPTT Dispatcher (Dispatcher 1) and two

other SIP clients (Linphone, MicroSIP, 3CX, or SmartPTT Dispatcher) (Dispatcher 2, Dispatcher 3). These settings

allow Dispatcher 1, Dispatcher 2, and Dispatcher 3 to interact with one another as 3CX server subscribers.

In order to do this:

1. Create SIP accounts for three SIP clients using the selected VoIP service provider, for example, accounts with

ID = 105, 106, and 107 on the 3CX SIP server.

2. In the SIP Accounts tab, as Dispatcher 1 add records corresponding to the created SIP server accounts with

ID = 105; Dispatcher 2 – with ID = 106; Dispatcher 3 – with ID = 107.

3. As Dispatcher 1 add records of the two subscribers (Dispatcher 2, Dispatcher 3). Connection with these

subscribers will be established via SIP server accounts.

Add the new subscribers in the Telephone Subscriber window. Fill in the Subscriber field. Click Full Address

(Automatic can also be selected if VoIP Gateway Default Settings allow you to connect to the selected SIP

server) and specify the outgoing and incoming SIP addresses corresponding to the called subscriber. Select the

Dispatcher 1 SIP account in the Enable SIP Account field (see step 2).
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Created subscriber entries appear in the Telephone Subscribers window.

4.  Complete the same settings for Dispatcher 2 (create account with ID = 106 in the SIP accounts tab; add

subscribers 105 and 107 in the List of Subscribers tab) and Dispatcher 3 (create account with ID = 107 in the

SIP accounts tab; add subscribers 105 and 106 in the List of Subscribers tab).
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5. To apply settings, click Finish in the Telephone Settings and in the Telephone Interconnect windows.

How to Call a Telephone Subscriber

To call the telephone subscriber from the dispatch console, click the button :

At that you will see the following window:
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To call the telephone subscriber, select it from the list and click Connect. In the Telephone subscribers tab you

can see not only added telephone subscribers, but also unregistered telephone subscribers (their numbers are in 

italics), and three latest calls (at the top of the list).

is used for running a conference call with the selected telephone subscriber. For more information about this

function see Conference Calls.
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To make a call to a telephone subscriber not on the list, go to the Dial Pad tab. You can dial the telephone

number or enter it in the input field above the dial pad.

If you need to dial an extension to reach a telephone subscriber, do the following: 

1. Dial the phone number after which you will need to add the extension. Then, you will see a new tab 

Extension Dialing.
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2. In this tab, dial * to turn on DTMF mode (not obligatory, depends on the telephone parameters).

3. Dial the extension number and then #.

If the incoming call is made by a telephone subscriber, who is not on the list, you can add the subscriber by

clicking on the Add button, which will appear.
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To connect a radio subscriber or a talkgroup to a telephone subscriber, open the Call Window of the radio

subscriber or the talkgroup and click the Call Telephone Subscriber button.

You can also use Action List, where you can select Call Telephone Subscriber. At that the following window

will open.
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Select the telephone subscriber from the list and click Connect or double-click on the list item. This list is taken

from the list of telephone subscribers created in the Telephone Subscribers window. If the subscriber is not on

the list, click Dial Pad to enter the telephone number manually.

At clicking Connect, a new window with the call status opens.

There are three statuses:

· Ringing

· Call

· Call Complete

If the connection attempt is failed, status window shows the corresponding error message.

To manage the call process, the dispatcher can use the buttons next to the call status:
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 - stops the call. Should the radio subscriber make a call right after the telephone call, it is necessary for him

or her to wait for a special tone notifying about the end of the call. If the radio subscriber presses the PTT button

before this tone, an incorrect phone call will be initiated.

 - initiates reconnection to the telephone subscriber.

1.5.19  Job Ticket Statuses

Here you can create job ticket statuses and specify their settings. For example, assign a color to a status or add

alert on status change.

To create job ticket statuses, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher

window and click Job Ticket Statuses. At that, the following window opens.

Enable Automatic Numbering – when this option is enabled, a unique number is assigned to each new job

ticket. It is necessary to distinguish job tickets with same names.

Send notification to subscriber when uncompleted job ticket was deleted by dispatcher – if this option is

enabled, a radio subscriber receives a message, if an incomplete job ticket was canceled.
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Default Status – the job ticket status which is displayed when the operator creates a new job ticket. The status

does not change, until the radio subscriber modifies it. You do not need to set this status in the MOTOTRBO CPS

settings. It is used only in SmartPTT Dispatcher, so you can add any value you like.

In the Color field select the color for the default status.

To add a job ticket status, click Add.

Name – name of the status.

Color – color of the status, which will be used in the job ticket table.

Completion status – it is the final status of a job ticket. If a job ticket has such a status and if Remove job

ticket from the list within n seconds after completion is enabled, the job ticket will be hidden from the list.

Note: You can also select the Completion status later in the Job Tickets configuration window.

Sound – this setting enables the sound signal which will notify the operator that a job ticket changed its status.

Warning! Added statuses must match the statuses set in MOTOTRBO CPS.

If the statuses of SmartPTT Dispatcher does not correspond to statuses in MOTOTRBO CPS, all settings (color,

sound signal and status completion) won't be applied. 
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1.5.20  Third-Party Equipment

SmartPTT system supports third-party equipment, for example, Tipro modular console with BeFREE

touchcomputer or without it.

To make the console work with SmartPTT system, take the following steps:

1. For Tipro modular console with BeFREE touchcomputer, install additional applications: ChangeMe Utility,

Tipro OPOS (these are delivered together with Tipro console), Microsoft Point of Service for .NET (POS for

.NET) v1.14 (http://www.microsoft.com/en-us/download/details.aspx?id=42081).

2. For Tipro modular console without touchcomputer, connect Tipro console to the PC with SmartPTT

Dispatcher installed. Install other additional software, such as ChangeMe Utility, Tipro OPOS (these are

delivered together with Tipro console), Microsoft Point of Service for .NET (POS for .NET) v1.14

(http://www.microsoft.com/en-us/download/details.aspx?id=42081).

3. Contact SmartPTT support team (http://support.smartptt.com/hc/en-us/requests/new) for Tipro configuration

file.

4. Apply the received Tipro configuration file using ChangeMe Utility.

5. Configure SmartPTT Dispatcher settings connected to Tipro support. 

The SmartPTT Dispatcher configuration includes the following steps:

http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://support.smartptt.com/hc/en-us/requests/new
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1. Open SmartPTT Dispatcher.

2. Enable Tipro console. On the Settings menu select Third-Party Equipment and then select Tipro

Console. In the opened window, select Enable.

At that, the version of the main Tipro module appears, and the settings become enabled. If device can't be

found, the settings are disabled.

3. Set up sound settings. You can go to the Sound Settings by clicking on Open General Settings to

change the current sound settings. You can also configure sound settings for the telephone module. This

is necessary only for Tipro modular console with BeFREE touchcomputer.
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4. Add hot keys. To do that, open the Hot Keys tab.

In the Subscribers and Actions box select the subscriber, subscriber group, dispatcher or action, to which

you want to assign a Tipro key. Then click on Set and press the required Tipro key. To save changes, click

on Finish. To get back to previous settings, click Cancel.

Reset All – removes all assigned hot keys.

1.5.21  Hot Keys

SmartPTT Dispatcher implements the ability to make a call to subscribers (radio subscriber, talkgroups, all call,

telephone subscriber, external dispatcher) by clicking on a predetermined keyboard key, its combination or a

button of the external input device. Also, dispatcher can repeat the last outgoing call or respond to the last
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incoming call by pressing the hot keys. In the Capacity Max systems dispatcher can also decline the incoming

call or end the call during the hang time by pressing the corresponding hot key.

In order to set up hot keys for system subscribers, expand the Settings menu in the Main Menu bar of the

SmartPTT Dispatcher window and click Hot Keys.

The window contains a list of subscribers available for the hot key assignment – radio subscribers, talkgroups,

telephone subscribers, external dispatchers, last called and last active subscribers. To assign a hot key to the

subscriber, select the subscriber from the list, then select the hot key type.

Keyboard – select the field to assign to the subscriber a keyboard key or a key combination as the PTT button.

Click Select, then press the keyboard key or the key combination.
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Not all keyboard keys can be used as hot keys. Here is the keyboard scheme. It shows which keyboard keys can

be used and which cannot.

1. The keyboard keys marked red cannot be used as hot keys separately or in combination.

2. The keyboard keys marked yellow cannot be used as hot keys separately, only in combination with the Ctrl,

Alt or Shift keys. The Shift key can be used only in combination of three keys, for example, Shift+Alt+F.

3. The Esc key can be used only in combination with Shift (Shift+Esc).

4. All other keyboard keys can be used as hot keys either separately or in combination with the Ctrl, Alt or Shift

keys. The Shift key can be used in combination of two or three keys, for example, Shift+Delete,

Shift+Alt+Enter.

Note: Hot keys support two work modes: holding and single press. The active mode is defined in Contol Devices.
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External Device – select the field to assign to the subscriber a key of the external input device connected via

USB as the PTT button. Select the external device from the list of available, click the Select button, then press

the key of the external device.

External Device COM Port – select the field to assign to the subscriber a key of the external PTT pedal

connected via COM port as the PTT button. Select the COM port of the PTT pedal from the list of available.

There is only one mode available for the PTT button on external devices – hold to enable.

To remove the previously defined hot key for the subscriber, disable the appropriate check box. To reset the

assigned hot keys for all subscribers, click Reset All.
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If a designated keyboard key or button of an external input device is already in use, the message appears in the

window:

A keyboard key or a key of the external input device which is already in use as the PTT button for a current

subscriber cannot be used as a PTT button for the selected subscriber.

Note: The PTT button used for a call to a current subscriber means that you use this button to call any subscriber

of SmartPTT Dispatcher.
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Note: If the hot key that you set matches the PTT button for the current subscriber, the hot key settings will be

discarded.

Click Finish to apply the settings. To get back to the previous settings, click Cancel.

1.5.22  Database Auto Backup

Backing up data on a regular basis helps to protect it from being erased in case of the server hardware or software

failure. SmartPTT Dispatcher allows the Administrator to back up the database manually or to set up parameters

for automatic backup.
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In order to set up automatic backup parameters, expand the Settings menu in the Main Menu bar of SmartPTT

Dispatcher and click Database Auto Backup.

Allow Database Auto Backup – select the check box to enable the ability to create SmartPTT Dispatcher

current database backups in the automatic mode. 

Backup Folder — full path to the file for saving the database backup.

Backup Settings — schedule for creating the current database backup:

· Daily — every fixed day at the specified time (for example, every day, every third day at 9:00 a.m.).

· Weekly — every fixed day of the week at the specified time (for example, every Monday, Wednesday and

Friday at 11:00 p.m., or every Monday at 11:00 p.m. and Friday at 11:00 a.m.).

· Monthly — once a month on the fixed day of the selected month and at the specified time.
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Backup Period — allows you to set time period when automatic database backup is to be made according to the

selected backup settings.

Note: The number of stored backup files in the same folder is limited to 3. Otherwise, when creating a new copy,

the old files are deleted.

Note: To restore the database from the automatically created backup, see Database.

1.5.23  Rules and Alerts

You can set response rules for the events registered in SmartPTT system. Response rules may include automatic

sending of messages, playing alerts in SmartPTT Dispatcher and on the radio, changing radio subscriber status,

etc. 
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To set rules, expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and click

Rules and Alerts. The configuration window opens up.



194Settings

Dispatcher User GuideSmartPTT PLUS 9.1

To add a new rule, click Add. The window with rule settings opens up.

Name – the name of the rule.

Active – select this check box to make the rule enabled.

The following table presents conditions that can be used in rules.

Attribute Operation Value

Direction No, Equals Incoming, Outgoing

Event Type No, Equals, Not Equals Registration, Call, Message, Telemetry,

Alarm, Status, Block Radio, Job Ticket,

Lone Worker
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Date/Time No, In Interval Time interval

Additional Information No, Equals, Contains Type event additional information, e. g. 

text messages, titles and description of

tasks, talkers from a group call.

Not Read No, Equals Read, Not Read

Operator No, Equals, Not Equals Operator from list of operators

Radioserver No, Equals, Contains Radioserver name

Control Station No, Equals, Contains Control station name

Subscriber No, Equals, Not Equals Subscriber from the list of subscribers

Talkgroup No, Equals, Contains Talkgroup name

Status No, Equals, Not Equals Status from the list of statuses

Duration No, Equals, Not Equals,

Greater, Greater than or Equal,

Less, Less than or Equal, In

Interval

Duration in seconds

Connection Type No, Equals, Not Equals Connection types used in SmartPTT:

· DMR – over-the-air connection made via

repeaters and control stations;

· PBX – telephone connection

· IP – Dispatcher-Dispatcher connection.

Repeater IP No, Equals, Not Equals Available repeaters' IP addresses

Receiver No, Equals, Not Equals Subscriber from the list of subscribers

Record No, Equals Available audio records

Attribute – contains the list of existing events which the system can register.

Operation – list of possible system operations for this attribute.

Value – values that can be selected for the attribute.
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The rule is a combination of an attribute, operation and value. One rule can contain more than one such

combinations.

When the system has registered an event matching the specified rule, the system performs predefined actions:

1. Alerts addressed to the initiator

2. Alerts addressed to the dispatcher

3. Alerts addressed to the radio subscriber

4. Other

Note: If the conditions of the rule include Incoming (Direction), Telemetry (Type) and a selected talkgroup

(Talkgroup), the rule will be triggered regardless of the talkgroup ID where the telemetry command was sent.    

The Message Format tab allows you to set the format of the alert massages.

To save the rule, click OK. At that, the created rule appears in the list of rules.

To edit the rule, select it in the list of rules and click Edit. To remove the rule, select it in the list of rules and click

Delete.

Initiator Alert

Open the Initiator Alert tab. In this tab you can set up actions that will be performed if the rule conditions are

fulfilled.

Block Radio – if selected, the radio that triggered the rule, will be blocked.

Lone Worker – if selected and On is clicked, the lone worker profile will be set to the radio that triggered the rule.

If Off is clicked, the lone worker mode of the radio will be deactivated.

Note: To set up the lone worker profile, see Lone Worker Rules in SmartPTT Dispatcher.
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Message – a text message is sent to the subscriber who initiated triggering of the rule. You can specify message

format settings in the Message Format tab.

Dispatcher Alert

Open the Dispatcher Alert tab.

Play Sound – select .wav audio file to play.

Show on Map – if selected, the radio that triggered the rule will be shown on the map.

Alert – notification with the event description is displayed in the System Notification window. You can define the

title in the Alert Caption field and the description in the Alert Text field.

Set Subscriber Status – the subscriber is assigned the predefined status. It is selected from the Statuses list

(see Statuses).

Subscriber Alert

Open the Subscriber Alert tab.
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Send Message – a text message is sent to the selected subscribers, talkgroups or categories. You can specify

format settings of text messages in the Message Format tab of the Actions area.

Other

Open the Other tab.

HTTP Request – is used for notification of the third party server of the changes occurred in SmartPTT system. It

can render the event initiator radio ID and its status. 

The HTTP request includes the following parts:

Note: Make sure that you have specified correct names for parameters 1 and 2. They must correspond to the

parameters' names expected by the third party server.

Note: Under "@Status" SmartPTT system will send the system message corresponding to the newly assigned

status selected in the Dispatcher Alert tab. Status system messages are set in the Statuses settings.
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E-mail – is used for specifying e-mail address where a message should be sent in case the rules specified earlier

are fulfilled. To do this, the following fields are to be filled:

Radioserver – server name which is configured for e-mail sending. The name of the server is selected from the

drop-down list.

E-mail – electronic addresses to send messages.

Message – text of the message.

SMS – if selected, the SMS message is sent to the specified phone number in case the rules specified earlier are

fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for SMS messages sending. The name of the server is selected from the drop-down

list.

Phone Numbers – telephone numbers to send SMS to. The preferred number format is International Number

Format, i.e. <+><country code><mobile code><phone number>.

Message – text of the message.

Note: See information about SmartPTT Radioserver configuration for sending and receiving e-mails, and SMS

messages in SmartPTT Radioserver Configurator Help under Telephone Interconnect and SMS Gateway.

You can specify format settings of SMS or E-mail messages in the Message Format tab of the Actions area.

Message Format

You can specify message format (text messages, SMS, or E-mail) in the Message Format tab of the Actions

area. These messages are sent to radio subscribers, defined in the message recipient list in the Subscriber

Alert or Other tab.
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Note: The format settings for text messages are valid for specific messages, only if Send Message is selected in

the Subscriber Alert tab; for SMS – if SMS is selected in the Other tab; for E-mail – if E-mail is selected in the

Other tab.

Event Information:

Event Type – if selected, the message includes the type of the event, which triggered the rule.

Date/Time – if selected, the date and time of the event will be added to the text message. You can set the date

format displayed in the message (date and time, or time only).

Time Zone – if selected, the message includes subscriber time zone in Coordinated Universal Time (UTC).

Coordinates – if selected, the subscriber's coordinates are displayed in the message. These are the latest

coordinates stored in the database.

Subscriber Information:

Subscriber ID – if selected, the ID of the subscriber, who has triggered the rule, will be added to the text

message.

Subscriber Name – if selected, the name of the subscriber, who has triggered the rule, will be added to the text

message.

1.5.24  Positioning Rules

You can set response rules for GPS and Indoor events registered in SmartPTT system. GPS events include

receiving or not receiving subscriber’s GPS coordinates, and Indoor events include receiving or not receiving

positioning data from special beacons. Response rules may include automatic sending of messages, playing

alerts in SmartPTT Dispatcher and on the radio, changing radio subscriber statuses, etc. 
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To set up a positioning rule, expand the Settings menu in the main menu and click Positioning Rules.
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To add a new rule, click Add. In the window that opened specify parameters of the future rule.

Active – if the check box is selected, processing of events starts in accordance with the selected criteria. If the

check box is not selected, the rule is unavailable.

Name – name of the rule.

There can be two kinds of positioning rules: Indoor and GPS. 

Type – rule types:

· Stop control – this rule type checks if a radio subscriber is moving, i.e. the subscriber's coordinates or

Indoor positioning data constantly change with time.

· Location data received – this rule type checks the appearance of the radio subscriber's coordinates after a

predefined period of time when there were no coordinates.
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· No location data – this rule type checks if there are no radio subscriber coordinates for a period longer than

the specified period of time. Coordinates like "...Lat: 0 Long: 0" are not regarded as valid coordinates, and

they won't be taken into account when applying positioning rules.

· Zone/route entry – this rule type checks if the radio subscriber has entered the zone or the route, i.e. the

subscriber's previous coordinates were outside the defined zone or route, and the current coordinates are

within this zone or the route.

· Zone/route exit – this rule type checks if the radio subscriber has left the zone or the route.

· Speeding –  this rule type checks if there was any speeding based on the received GPS data.

· Number of subscribers in geofences / on routes – this rule type checks the number of radio subscribers

in the selected geofences or on selected routes.

The table lists the criteria used in positioning rules.

Attribute Value

All subscribers

Select Subscribers / Select

Categories

Select all subscribers, or some subscribers, or categories, to whom

the rule will be applied.

Time period with no motion detected Time interval during which the radio subscriber can stay at one place

(min)

Time period before receiving

location data

Period of time after which the subscriber's coordinates are received

again (min)

Time period with no location data

received

Period of time during which there are no subscriber's coordinates

(min)

Geofences and Routes Select geofences or routes to follow in the rule.

Speeding

If speeding is registered, the rule is executed.

Note. The rule triggers only when over-speed occurs in the area of the

selected geofence or on the selected route. Otherwise, the rule is not

triggered.

Number of subscribers in geofences /

on routes

The number of radio subscribers in selected geofences or on selected

routes.



204Settings

Dispatcher User GuideSmartPTT PLUS 9.1

Attribute Value

Select Area (Geofences/ Routes) Select geofences or routes to follow in the rule.

Notify constantly

Select this check box to notify the dispatcher about violation of one of

the criteria every time it happens. If the check box is not selected, the

actions which follow the violation of the specified criteria will occur

only once.

Notify about new location

If the subscriber starts moving, and before that the subscriber stopped

for a time period longer than the specified one, the notification window

will be displayed

If the rule meets selected criteria, the system can perform a series of actions:

1. Actions addressed to the initiator

2. Alerts addressed to the dispatcher

3. Alerts addressed to the radio subscriber

4. Other

If finished, click OK to save the rule, and the created rule appears in the list of rules.

To edit rule settings, select it in the list of rules and click Edit. To remove the rule, select it in the list of rules and

click Delete.

Initiator Alert

Open the Initiator Alert tab.

Block Radio – if selected, the radio that triggered the rule, will be blocked.
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Lone Worker – if selected and On is clicked, the lone worker profile will be set to the radio that triggered the rule.

If Off is clicked, the lone worker mode of the radio will be deactivated.

Note: To set up the lone worker profile, see Lone Worker Rules in SmartPTT Dispatcher.

Message – a text message is sent to the subscriber who initiated triggering of the rule.

Dispatcher Alert

Open the Dispatcher Alert tab.

Play Sound – select .wav audio file to play back.

Show on Map – location of the subscriber specified in the rule is shown on the map (with an icon).

Alert – notification with the event description is displayed in the System Notification window. You can define the

title in the Alert Caption field and the description in the Alert Text field.

Note: For rules Stop control and No location data the alert text cannot be set – it is generated by the system

automatically.

Set Subscriber Status – the subscriber is assigned the specified status. It is selected from the list of statuses.

Subscriber Alert
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Open the Subscriber Alert tab.

Send Message – a text message is sent to the selected subscribers, talkgroups or categories.

Other

Open the Other tab.

HTTP Request – is used for notification of the third party server of the changes occurred in SmartPTT system. It

can render the event initiator radio ID and its status. 

The HTTP request includes the following parts:
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Note: Make sure that you have specified correct names for parameters 1 and 2. They must correspond to the

parameters' names expected by the third party server.

Note: Under "@Status" SmartPTT system will send the system message corresponding to the newly assigned

status selected in the Dispatcher Alert tab. Status system messages are set in the Statuses settings.

E-mail – is used for specifying e-mail address where a message should be sent in case the rules specified earlier

are not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for e-mail sending. The name of the server is selected from the drop-down list.

E-mail – electronic addresses to send the message.

Message – text of the message.

SMS – if selected, the SMS message is sent to the specified phone number in case the rules specified earlier are

not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name which is configured for SMS messages sending. The name of the server is selected

from the drop-down list.

Phone Numbers – telephone numbers to send SMS. The preferred number format is International Number

Format, i.e. <+><country code><mobile code><phone number>.

Message – text of the message.

Note: See information about SmartPTT Radioserver configuration for sending and receiving e-mails and SMS

messages in SmartPTT Radioserver Configurator Help under Telephone Interconnect and SMS Gateway.

1.5.25  Lone Worker Rules

SmartPTT Dispatcher supports the Lone Worker mode for radio subscribers.
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When a subscriber is set to the Lone Worker mode, SmartPTT automatically tracks the following conditions:

· Absence of calls from the subscriber during specified period of time.

· Absence of GPS coordinates from the subscriber during specified period of time.

· Immobility of the subscriber during specified period of time.

When one of the specified conditions triggers, SmartPTT Dispatcher executes the actions defined by the settings.

To define special rules or profiles for lone workers, expand the Settings menu in the Main Menu bar of the

SmartPTT Dispatcher window and click Lone Worker Rules. At that, the window for creation and/or editing the

rules for lone workers opens.

Here you can see the list of rules which get executed if the specified conditions are fulfilled. SmartPTT supports

multiple rules, so it is possible to create a lone worker rule for each radio subscriber.
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To add a new rule, click Add. To make changes in the existing rule, select it and click Edit. To delete a rule,

select it from the list and click Delete. 

Note: The default profile cannot be deleted.

At clicking Add or Edit, the Profile Settings window opens.
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In the Profile Settings window you can set up rules for a new profile or edit rules for the existing profile. The

window contains the following fields and sections:

Name – name of the profile. It is an obligatory field. 

The General tab contains rule conditions to trigger an alert:

No calls – specifies the period of time for a subscriber to make a voice call. If the subscriber does not make a call

during the specified time period, the corresponding actions are executed.

No location data received – specifies the period of time for a subscriber to send GPS or Indoor data. If the

subscriber radio does not send its GPS or Indoor data during the specified time period, the corresponding actions

are executed.

No change in location data – specifies the period of time to check if a subscriber is moving. If the subscriber

GPS data (GPS data accuracy is 5 meters) or Indoor data do not change during the specified time period, the

corresponding actions are executed.

Note: The No change in location data rule condition triggers only if the dispatcher receives radio GPS or Indoor

data. So the No change in location data rule condition must be used together with the No location data

received rule condition.

The Subscriber Alert area:

Text Message – when the event specified in one of the filters occurs, the text message is sent to the lone

worker.

Audio Message – when the event specified in one of the filters occurs, an audio message is sent to the lone

worker. To record the message, click the Record button. To stop recording, click the Stop button. To listen to the

recorded message, click Play. To delete the recorded message, click Delete.

Call Alert – when the event described by one of the filters occurs, a Call Alert is sent to the lone worker.

The Actions delay timer defines the time interval after which Actions will be executed after Subscriber Alert. 

If the rule meets selected criteria, the system can execute the following actions:

1. Actions addressed to the initiator

2. Alerts addressed to the dispatcher

3. Alerts addressed to the radio subscriber

4. Other

To save the rule, click OK. At that, the created rule appears in the list of rules.
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To edit rule settings, select it in the list of rules and click Edit. To remove  the rule, select it in the list of rules and

click Delete.

Initiator Alert

Open the Initiator Alert tab.

Block Radio – if selected, the radio that triggered the rule, will be blocked.

Lone Worker – if selected and On is clicked, the lone worker profile will be set to the radio that triggered the rule.

If Off is clicked, the lone worker mode of the radio will be deactivated.

Note: To set up the lone worker profile, see Lone Worker Rules in SmartPTT Dispatcher.

Message – a text message is sent to the subscriber who triggered the rule.

Dispatcher Alert

Open the Dispatcher Alert tab.
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Play Sound – select the audio file to play in SmartPTT Dispatcher. The supported audio formats: MP3, OGG,

WAV.

Show on Map – subscriber specified in the rule is shown on the map (with an icon).

Alert – notification with the event description is displayed in the System Notification window. You can define the

title in the Alert Caption field. and the description in the Alert Text field. Description of the event can't be set, it

is generated automatically.

Set Subscriber Status – the subscriber is assigned the specified status. It is selected from the list of statuses.

Subscriber Alert

Open the Subscriber Alert tab.

Send Message – a text message is sent to the selected subscribers, talkgroups or categories.

Other
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Open the Other tab.

HTTP Request – is used for notification of the third party server of the changes occurred in SmartPTT system. It

can render the event initiator radio ID and its status. 

The HTTP request includes the following parts:

Note: Make sure that you have specified correct names for parameters 1 and 2. They must correspond to the

parameters' names expected by the third party server.

Note: Under "@Status" SmartPTT system will send the system message corresponding to the newly assigned

status selected in the Dispatcher Alert tab. Status system messages are set in the Statuses settings.

E-mail – is used for specifying e-mail address where a message should be sent in case the rules specified earlier

are not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for e-mail sending. The name of the server is selected from the drop-down list.

E-mail – electronic addresses to send the message.

Message – text of the message.
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SMS – if checked, the SMS message is sent to the specified phone number in case the rules specified earlier are

not fulfilled. To do this, the following fields are to be filled:

Radioserver – server name for SMS messages sending. The name of the server is selected from the drop-down

list.

Phone Numbers – telephone numbers to send SMS. The preferred number format is International Number

Format, i.e. <+><country code><mobile code><phone number>.

Message – text of the message.

Note: See information about SmartPTT Radioserver configuration for sending and receiving e-mails and SMS

messages in SmartPTT Radioserver Configurator Help under Telephone Interconnect and SMS Gateway.

How to assign a Lone Worker Profile to the radio subscriber

To assign the created lone worker profile to a radio subscriber, open the Properties window of the subscriber.

In the opened window select the Lone Worker check box, and in the drop-down list select the created profile.

To remove the profile from the subscriber, clear the Lone Worker check box.
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1.5.26  Subscriber Custom Properties

SmartPTT Dispatcher provides the ability to add custom properties of a subscriber, which can be used for giving

additional information about the radio subscriber. Subscriber Custom Properties have the following four types: 

1. Text

2. Numeric

3. Date

4. List

To create custom properties expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher

window and click Subscriber Custom Properties. At that, the Subscriber Custom Properties window opens.

The top list contains subscriber custom property groups.
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To add the subscriber custom property group, click Add at the top. To delete the group, click Delete. Arrows on

the right allow moving groups inside the list.

The bottom list contains the properties of the created groups.

Property Name – custom name of the property which will be displayed in the Properties window.

Type – property type (Text, Numeric, Data or List).

Description – text description added by the user when creating a property.

Active – select the check box, to have the property displayed in the Properties window.

To add a property into the property group, select the created property group in the top list and then click Add

above the bottom list.

At that, the Subscriber property window opens.

Fill all the fields required. Select the Type and click OK. 

Note: If you want to select List in the Type field, before that you need to create the list. Otherwise, the list will be

empty.



217Settings

Dispatcher User GuideSmartPTT PLUS 9.1

To create the list, click the Create/Edit Lists button  . At that, the window opens:

In the top box add list names by clicking Add.

Select the created list and add elements of the list. To do it, go to the bottom box and click Add just above it.
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To view the active custom properties go to the subscriber Properties window, Custom tab.

1.5.27  Custom Consoles

Custom Console is a tool that provides the dispatcher with custom workplace. Custom consoles are visual

panels containing various elements, e.g. radio subscribers, external dispatchers, talkgroups, in short, everything

the dispatcher need for daily work. Every dispatcher can have his own console with all the radio objects necessary

for his work.
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To create and set up a custom console, expand the Settings menu in the Main Menu bar of the SmartPTT

Dispatcher window and click Custom Consoles. At that, the Custom Consoles window opens.
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To add a new console, click Add. At that, the console editor will open.

Name: A name of a custom console which will be displayed in the Tools menu.

Wallpaper: Allows you to select an image for the background of the console. The supported formats are BMP,

JPG, PNG.

There are more than a dozen types of visual elements available in Custom Consoles. Description of each element

is given further in this article.

To add an element to the custom console, drag and drop the desired element onto the work space of the console

designer. To remove the element from the work space, select it and press Delete. To erase the last change or

perform the redo function click the Undo or Redo buttons.

You can adjust size, color or location of each element on the custom console. You can also add or remove

different properties. To do this, select the element and use the Misc or the Properties sections on the right of the

console designer work space. To move the element up, down, left, or right, press the arrow keys. To move the

element diagonally, press the Up or Down Arrow key and the Left or Right Arrow key. For example, to move the

element diagonally toward the upper-right corner, press Right Arrow-Up Arrow.
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Channel

The Channel element stands for a physical or logical channel. It gives the

following information about the channel:

· information about the current call on the channel – the call state, the called

party and the call originator;

· default target for outgoing calls (it can be either All Call or any particular

talkgroup);

· muted or unmuted;

· the number of missed incoming calls.

To mute the channel, click . Check the Mute Mode settings before applying

this function.

To open the Actions list which can be applied to an element, click .

To display the channel name as Radioserver name – Channel name, select the

Radioserver Name check box in the Misc section. Otherwise, only the

channel name will be displayed.

To view the number of missed incoming calls, select the Missed Calls check

box in the Properties section.

 shows the number of calls not answered by the dispatcher. The

red figure stands for the number of private calls not answered by the dispatcher.

The blue one shows the total number of calls not answered by the dispatcher,

including private and group calls. As soon as the dispatcher called back the

talkgroup or the radio subscriber, the counter is set to zero.
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By clicking the button, the window with details appears.

Missed (Dispatcher) – filters only private calls not answered by the dispatcher.

Missed (All) – filters private and group calls not answered by the dispatcher.

All – removes all filters and shows all available talkgroups and radio subscribers

and their call statistics.

Clear All – sets all counters to zero.

Talkgroup

The Talkgroup element stands for a talkgroup on the channel. You can

make a call to the selected talkgroup by clicking on the element.

To open the Actions list which can be applied to an element, click .

Also, the element displays that the radio subscriber enters emergency

mode (the Emergency icon appears), when the Emergency button is

pressed on the radio. Once the dispatcher solves the problem by clicking 

 in the Emergencies panel, he clears the emergency state on the

element of the Custom Console. Once the initiator clears the emergency

on the initiator radio, the emergency is considered over.

You can mute the group call by clicking on the Mute icon. The element also

shows the state of the current call.
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To display the channel name as Radioserver name – Channel name, select

the Radioserver Name check box in the Misc section. Otherwise, only the

channel name will be displayed.

Radio Subscribers

The Subscriber element for

certain radio subscriber

The Subscriber element for

optional radio subscriber

The Subscriber element is used for making private voice calls. There are

two types of the Subscriber element:

· The Subscriber element for certain radio subscriber—is used to call

the radio subscriber selected in advance, when adding the element to

the console.

You can also assign this type of element to different radio subscribers

from the drop-down list. To enable this option, select the Allow

Changes check box in the Properties section, when adding the

element to the console.

· The Subscriber element for optional radio subscriber—is used to call

the radio subscriber that can be selected using dial pad or list of radio

subscribers on the element.

To open the dial pad, click the button  in the bottom left corner of

the element. To select the necessary radio subscriber, enter its Radio

ID in the search field using the dial pad or keyboard.

To open the list of radio subscribers, click the button  in the bottom

right corner of the element.

The Subscriber element shows the radio subscriber name or its Radio ID,

if name is not specified.

 – the icon on the subscriber element shows that the dispatcher did not

answer to the subscriber call. The figure next to it shows the number of

missed calls.
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Also, the element displays that the radio subscriber enters emergency

mode (the Emergency label), when the Emergency button of the radio is

pressed. Once the dispatcher solves the problem by clicking  in the

Emergencies panel, he clears the emergency state on the element of the

Custom Console. Once the initiator clears the emergency on the initiator

radio, the emergency is considered over.

To open the Actions List which can be applied to an element, click .

To open the Call Window of the radio subscriber, right click the element.

Telephone Subscriber

The Telephone Subscriber element is used for making calls to telephone

subscribers. Double-clicking on the element opens the Call Window and

initiates the call.

Note: For proper operation of the element select Allow Calls to

Telephone Subscribers in the General Settings tab of the Telephone

Settings window.

You can assign the element to different telephone subscribers from the

drop-down list. To enable this option, select the Allow Changes check box

in the Properties section.

Note: To set the list of telephone subscribers, go to the Telephone

Subscribers window.

Dispatcher

The Dispatcher element is used for making connection to other

dispatchers. Double-clicking on the element opens the dispatcher's Call

Window and initiates the call.
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Note: For proper operation of the element make sure that the operator has

the permission Connect with external dispatchers (Settings >

Operators)

You can assign the element to different dispatchers from the drop-down list.

To enable this option, select the Allow Changes check box in the

Properties section.

Note: The list of dispatchers contains dispatchers added in the Dispatchers

window.

Channel Selector

The Channel Selector element allows the dispatcher to switch from one

channel of the control station to another.

Note: The functionality requires the control station to be connected to the

PC and its channels to be set up via MOTOTRBO CPS and SmartPTT

Radioserver Configurator.

Channel setting in SmartPTT Radioserver Configurator is carried out on the 

Channels tab of the control station. Channels listed on this tab must

match the channels set in MOTOTRBO CPS (channel number, zone

number).

To configure this functionality in SmartPTT Dispatcher, add the Channel

Selector element into the console designer work space. One element can

be assigned to one channel. To allow switching between channels, you

should add the required number of elements.
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Outgoing Telemetry

The Outgoing Telemetry element is used for sending telemetry commands

to the radio subscriber. You can assign only one telemetry command per

element. Before assigning the telemetry command to the element, add it to

the telemetry list of commands and to the radio subscriber. Apart from

sending commands, you can also check the current status and the time of

the last status update.

Incoming Telemetry

The Incoming Telemetry element is used for receiving the current status of

the selected pin. You can also see the time of the last status update.

Voice Notification

The Voice Notifications element starts or stops the voice notification and

displays how many times the voice notification is reproduced. To configure

voice notifications see the Voice Notification section in SmartPTT

Radioserver Configurator.

Note: To monitor the current status of the voice notification playing, open

the Voice Notifications window (Service > Voice Notifications).

To display the element name as Radioserver name – Voice Notification

name, select the Radioserver Name check box in the Misc section.

Otherwise, only the voice notification name will be displayed.
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Multiselect

The Multiselect element is used to make a simultaneous call to several

radio objects (talkgroups and radio subscribers) which were added in

advance by dispatcher to the Multiselect list.

To initiate a simultaneous call to the participants of the Multiselect list,

click the Multiselect element in the opened custom console. At that, all

participants will hear the dispatcher, but only the dispatcher will hear the

participant who answers the call.

To add radio objects to the Multiselect list, add the Multiselect element to

the custom console in the console editing mode, open the custom console

from the Tools menu and click the Edit list button on . In the Multiselect

window, that opened, add the required radio objects from the Radio Fleet

list to the Multiselect objects list, and click OK.

Note: You can create more than one Multiselect objects list, by adding the

corresponding number of the Multiselect elements to the custom console.

To edit the Multiselect list, click the Edit list button  in the opened

custom console.

Broadcast Call

The Broadcast Call element is used for making group calls or an All Call

within all the channels of the dispatch console simultaneously. Select the

required talkgroup or All Call ID in the Talkgroup ID field of the Properties

section. When such a call is initiated, SmartPTT Dispatcher tries to call all

of the subscribers with the given identifier.

Panel

The Panel element is used for uniting several elements. The panel can have

its own color, size and placement. All inside elements of one panel are

moved together with the panel.
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Image

The Image element is used for adding logos and other images to the

custom console. You can select the image file under the Properties

section on the right. The supported formats are BMP, JPG, PNG.

Incoming Events

The Incoming Events informs about incoming messages, call alerts and

missed private calls to SmartPTT Dispatcher from radio subscribers.

Double-click the record in the panel to open the subscriber's Call Window.

TMS

The TMS element is used for sending short text messages to all

subscribers or talkgroups situated in one panel with the TMS element. To

do this, just enter the text of the message or select a template, and send

it. If the TMS element is placed outside a panel, it will send private

messages. To do this, just select the radio subscriber, enter the text of the

message and send the message.

PTT

The PTT element is used for a multiple-user call. If it is located inside the

panel, clicking the PTT element makes a call to all the subscribers located

within this panel. If it is located outside the panel, the PTT element

becomes disabled.
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When in work, color of the elements with the assigned subscribers differs depending on the status.

Element Description

Gray – the subscriber is offline or outside the network coverage

Gray blue – the subscriber is online

Light yellow – the operator is trying to make an outgoing call

Yellow – all outgoing radio calls

Green – all incoming radio calls or the radio is being monitored

Light green – exists in the Capacity Max systems only and determines the incoming call

attempt to SmartPTT Dispatcher

Blue – none of the parties transmit or receive voice. The subscriber can answer the call by

pressing the PTT button within hang time. In the Capacity Max systems the dispatcher can

end the call during the hang time by right clicking the console element.

After the hang time expires, the subscriber initiates a new call by pressing the PTT button. The

calling subscriber is the subscriber linked with the PTT button by default.

Blue frame – the subscriber is selected

You can open the created custom consoles from the Tools menu. SmartPTT Dispatcher allows opening multiple

custom consoles simultaneously.

1.6  Service
The Service menu allows you to carry out secondary functions, namely:

· Radio Check allows you to send the radio check command to radio subscribers.

· Voice Notifications allows you to play voice notifications.

· Deferred Actions allows you to view and edit deferred actions.

· Received Files allows you to view files received by the radioserver via SmartPTT File Transfer.

· Radio Kill allows you to block a radio station irreversibly.
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· System Information allows you to check event statistics registered on the radioserver or in the dispatcher

console and other information on the system.

· Export Radio Subscribers allows you to save the list of registered radio subscribers in XML or XLS formats.

· Import Radio Subscribers allows you to import previously exported list of radio subscribers.

· Upload to KML allows you to export current geographical position of radio subscribers in KML format.

· Import Connect Plus Logs allows you to import data from the Connect Plus network.

· Save Dispatcher Settings allows you to save current settings of the dispatcher console and database to

restore them in the future.

· Restore Dispatcher Settings allows you to restore saved settings of the dispatcher console and the

database.

1.6.1  Radio Check

The Radio Check function can be executed on the selected control stations available to the dispatcher. The

result of the Radio Check is displayed in the subscriber Call Window. It can be: "Subscriber is available" or

"Subscriber is unavailable".

To do Radio Check, expand the Service menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Radio Check. At that, the Radio Check window opens.

Specify the IP of the subscriber radio. Select control stations which should be used to check the subscriber

availability and click Send.
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Alternatively, Radio Check can be done from the Call Window or the Actions List.

In the Actions List:

Note: If the connection to the Capacity Max system is performed via control station, the Radio Check command

will be unavailable.

1.6.2  Voice Notifications

The main purpose of the voice notification functionality is to warn talkgroups about the fire or other emergency and

to manage evacuation. However, in normal mode voice notification can be used for usual voice announcements.
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Warning! You can create voice notifications only in SmartPTT Radioserver Configurator (Radioserver >

Add-on Modules > Voice Notifications). You can run the created voice notifications from SmartPTT

Dispatcher.

To play a voice notification in selected systems, expand the Service menu in the Main Menu bar and click

Voice Notifications. At that, the Voice Notifications window will open.

Radioserver – select the radioserver from the list. The list contains only active and running radioservers,

registered in the dispatch console .

Voice Notifications – select a voice notification from the list of items created in SmartPTT Radioserver

Configurator.
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To play the voice notification, select the radioserver and the voice notification, and click Start. To stop playing,

click Stop.

Note: To play a voice notification, you can use the Voice Notification element, added to the custom console.

Note: When the voice notification is stopped, it does not stop playing immediately, but only after it played on all

selected channels within a single repetition.

Notifications Left – specifies the number of remaining voice notification repetitions.

Channels – contains a list of channels specified for the selected voice notification. Here you can also see the

current status of the voice notification playing, and the number of completed playbacks. The channel is highlighted

green, when voice notification playing was successfully completed on this channel. When voice notification can't

be played on the channel (for example, hardware or virtual device is not available at the moment), the channel is

highlighted red. While voice notification is played on the channel, the channel is highlighted yellow.

1.6.3  Deferred Actions

Deferred actions allow to deliver an information to the offline subscriber. When subscriber becomes online, it will

immediately receive it.

You can use deferred action for the online subscribers. They will receive them immediately after the creation.

SmartPTT Dispatcher allows you to create, edit, view and delete two types of deferred actions:

· voice messages,
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· text messages.

Note: Operator of SmartPTT Dispatcher should have the right to create deferred actions.

You can create a deferred action in two ways:

· Double-click the subscriber in the Radio Fleet window and click Create Deferred Action icon in the

subscriber window.
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· Click the Action button ( ) next to the subscriber and click Create Deferred Action.
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At that, the Create Deferred Action window will be opened:

Radioserver: A list of the active radioservers, to which a subscriber belongs.

Send Audio Message: Select to create a voice message:

· click Record and start the recording of the voice message. When you do, the button changes to Stop.

Click it to stop the recording.

· click Play to play the recorded message. When you do, the button will change to Stop. Click it to stop the

recording.

If you dislike the voice message, you can rewrite it by recording a new voice message.

Send Text Message: Select to create a text message:

· type your text message if the field below.

Note: If you unselect Send Text Message, the text will be kept in the field except it becomes unavailable and will

not be included into action when you will save it.

Save: click to save the action. At this, your message will be transmitted to the radioserver, so the execution of

the deferred action is independent on SmartPTT Dispatcher. You will be notified about the successful creation of

the derferred action or issues that resist its creation.

Cancel: click to cancel the creation of the action or adding changes to it.
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View Deferred Actions: Closes the Create Deferred Action window without saving and opens the Deferred

Actions list.

In this list you can view deferred actions which were not executed yet (queued actions). When the deferred action

is executed, it will be removed from the list.

Current Radioserver: Select the radioserver to view actions which it should execute.

Note: If you do not see your radioserver in the list, check if it is active in the Radioservers menu.

Load Action List: Click to show or refresh the list of deferred actions on the selected radiosever.

Edit: Click to change the selected action. At this, Create Deferred Action will be opened again.

Delete: Click to delete the selected action. Be careful with this, because no notifications occur at this action.

1.6.4  Received Files

SmartPTT Dispatcher provides the ability to view files sent from radio stations with the help of a free application

SmartPTT File Transfer.
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To view the files received from radio stations, expand the Service menu in the Main Menu bar and click

Received Files. At that, the following window opens.

Current Radioserver – allows selecting files from one available radioserver or all available radioservers.

Retrieve File List – loads received files for the selected radioserver.

Download – opens the window for saving the selected file. You can also open this window by double-clicking on

the selected file.

Delete – deletes the selected file from the list.

Close – closes the Received Files window.

1.6.5  Administration

Radio Kill

Capacity Max system supports the Radio Kill function, which allows to block a radio irreversibly.

Note: After sending Radio Kill to the radio, you can restore this radio only in Motorola service

center.
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To send Radio Kill to the radio, perform the following actions:

1. Expand the Service menu in the Main Menu bar of the SmartPTT Dispatcher window and click

Administration > Radio Kill. At that, the Radio Kill window opens.

2. In the Radio ID field enter the radio unique identifier. If this identifier has a name in the SmartPTT Dispatcher

database, this name will be displayed on the right. To continue, click OK. To cancel the command, click the

Cancel or Cross button.

Pay attention that the Radio Kill command can be executed only under the following conditions:

· The radio is registered in a network (it is online),

· The radio identifier is in the range of allowed radio IDs for radioserver and profile configured in SmartPTT

Radioserver Configurator (for more detailed information refer to SmartPTT Radioserver Configurator User

Guide).

If one of the given conditions is not fulfilled, after clicking OK the Warning window will open and Radio Kill will

not be sent.
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3. If all the conditions described above are fulfilled, after clicking OK the Enter Password window will open. In

the Operator password field enter the password used to log in SmartPTT Dispatcher. To send the Radio

Kill command, click OK. To cancel the command, click the Cancel or Cross button.

Attention! After clicking OK you will be able to restore this radio only in Motorola service center.

1.6.6  System Information

The System Information window contains brief information about the usage of the SmartPTT network systems.

To call this window click System Information in the Service menu of the Dispatcher main menu.
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1.6.7  Export Radio Subscribers

SmartPTT Dispatcher provides the ability to export subscriber list from one SmartPTT Dispatcher and then to

import it into another. Only registered radio subscribers can be exported.

To export the list of radio subscribers, expand the Service menu in the Main Menu bar and click Export Radio

Subscribers. At that, the following window opens.
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In the Format area select the format in which you want to export the subscriber list. To select the file for export,

click  . Supported file formats: XLS, XML and CSV. Then click OK. At that, the file with the exported data will

open.

The example of the exported file in XLS format:

The example of the exported file in XML format:

ID — automatically generated ID of the radio subscriber.

IP Address – radio subscriber IP address.

Network ID – network ID which is specified in MOTOTRBO Customer Programming Software (see parameter CAI

Network).

Radio ID – unique identifier of the radio unit.

Name – radio subscriber name specified in the subscriber's Properties window in SmartPTT Dispatcher. 
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GPS – shows whether the radio supports GPS.

MDC ID – radio ID in the analog data channel.

Icon – path to the icon selected per subscriber. If a radio subscriber has a default icon, the corresponding field in

the export file is empty.

Show on map – shows whether the subscriber's location is visible on the map.

Lone Worker – shows whether the subscriber is in the "lone worker" mode.

Select 5 ID – shows the 5 Tone identifier of the subscriber.

Indoor Support – shows whether the subscriber is visible on the building plan by the dispatcher request or after

the predefined time period.

Indoor Request – shows whether the option Update Interval for Indoor Tracking is selected.

Indoor Update Interval – the time interval in seconds for location data update from special beacons, which are

installed in buildings.

GPS update with time interval – shows whether the GPS Update location with time interval option is

selected.

Time Interval – shows the time interval in seconds after which the GPS coordinate request will be sent to the

radio subscriber.

GPS update with distance interval – shows whether the GPS Update location with distance interval option

is selected.

Distance Interval – shows the distance interval in meters or feet after which the GPS coordinate request will be

sent to the radio subscriber.

GPS on GPIO pin status change – shows if the GPS coordinate request will be sent to the radio subscriber

when the status of telemetry contacts changed.

GPS on emergency – shows if the GPS coordinate request will be sent to the radio subscriber when the radio

subscriber sends an emergency alarm.

Note: The following properties of the subscriber in exported files may have two possible values: "True" or "False"

in XLS and CSV files; "Yes" or "No" in XML files: GPS, Show on map, Lone Worker, Indoor Support, Indoor

Request, GPS update with time interval, GPS update with distance interval, GPS on GPIO pin status

change, GPS on emergency.
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1.6.8  Import Radio Subscribers

SmartPTT Dispatcher provides the ability to import subscribers (in XLS, XML and CSV) from one SmartPTT

Dispatcher to another. 

To import the list of radio subscribers, expand the Service menu in the Main Menu bar and click Import Radio

Subscribers. At that, the following window opens.

In the Format area select the format in which you want to import the subscriber list. To select the file for import,

click  . Then select the import options.

Add New Records – when the check box is selected, at importing, new subscribers (not existing in SmartPTT

Dispatcher) will be added to the list of subscribers.

Update Existing Records – when the check box is selected, at importing, the existing data on the subscribers in

SmartPTT Dispatcher is replaced with the data from the imported file.

Note: It is possible to select both import options at a time. At that, new records will be added and the existing

records will be updated.

Click OK to launch import process.

Click Cancel to close the window.

Note: To apply changes after importing, it is important to restart SmartPTT Dispatcher.

The formats of the importing files should match the formats of the exported files.
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1.6.9  Upload to KML

SmartPTT Dispatcher supports export of the current subscribers' coordinates in KML format. This format is used

in Google Maps/Google Earth systems.

To save subscriber coordinates in KML file format, expand the Service menu in the Main Menu bar of the

SmartPTT Dispatcher window and click Upload to KML. At that, the following window opens.

The interface of the window depends on where you selected to store the KML file – to a local folder or to FTP.

Click Local File to keep the uploaded KML file locally.

KML File – specify the destination folder and the name of the KML file with the subscriber coordinates.

You can also set up automatic upload. Simply, select the Auto upload time interval check box and enter the

time interval.

When everything is ready click Export to launch the upload process.

You can also store the uploaded file on FTP. To do that, click FTP at the top of the window.
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KML File – specifies the destination folder and the name of the KML file with the subscriber coordinates on the

FTP server.

Fill in the Login and Password fields if the FTP server requires authentication.

To exit and save the settings, click Close.

To exit without saving the settings, press ESC.

How to display subscribers' coordinates

To view subscriber coordinates from the FTP file:

1. Open the website http://www.google.com.

2. Click on Maps (the page http://maps.google.com/maps?hl=en&tab=wl is displayed).

3. Enter a direct HTTP link to the file located on the FTP server (for example, 

http://myserver/smartptt/Radios_smartptt.kml) in the Google maps field and click Search Maps.

To view subscriber coordinates from the local file in Google Earth:

1. Start Google Earth.

2. Select Open (from the File/Open menu or press CTRL+O).

3. Specify the path to the local file with the subscriber coordinates in KML format and click Open.

How to configure subscribers' coordinates display with automatic update in
Google Earth

1. Start Google Earth.

2. Select the menu command Add/Network Link.

3. In the Name field specify the place mark name to be displayed in Google Earth.

4. To view the file from the FTP server, enter a direct HTTP link to the file located on the FTP server (for

example, http://myserver/smartptt/Radios_smartptt.kml).

To view the file from the local disk, click Browse, specify the path to the file with subscriber coordinates in KML

format and click Open.

5. Click the Refresh tab, select the Periodically option and set an update interval.

6. Click ОК: SmartPTT subscribers should now be displayed in Google Earth.

7. To open the added KML file automatically the next time Google Earth is run, you should save the temporary

place mark "Subscribers (SmartPTT)" to My Places list. To do this please select the menu command

File/Save/Save to My Places or press CTRL+SHIFT+S.

http://www.google.com/
http://maps.google.com/maps?hl=en&tab=wl
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1.6.10  Import Connect Plus Logs

SmartPTT Dispatcher allows importing Connect Plus Logs to the Event Log. This is useful for dispatchers

joining a new Connect Plus radio network to get data on the events in this network. The data is taken from the

XRC Controller.

To import Connect Plus Logs, expand the Service menu in the Main Menu bar of the SmartPTT Dispatcher

window and click Import Connect Plus Logs. The Import Connect Plus Logs window opens.

Logs File – specifies the path to the folder where Connect Plus log file is stored. 

CAI – CAI-Network identifier. It’s recommended to use the default value 12. It is set in the range from 1 to 126.

CAI for Groups – the identifier of the group's CAI-Network. It’s recommended to use the default value 225. It is set

in the range from 225 to 239.

If you click Import, Connect Plus data import to the Event Log will be started.

All Files – displays the total download progress.
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When Connect Plus Log file is imported, you will see the following notification window.

1.6.11  Save Dispatcher Settings

Starting from version 8.3 you can save and restore not only the event log database, but also the dispatch console

settings. These includes: opened panels, the application interface language and other settings.

To save current settings or database, open the Service menu and select Save Dispatcher Settings. At that, the

following window opens up:

Objects – define what you want to save. You can select both, if needed. 

Archive File – specify the path to the folder where you need the archive to be saved.

To save the selected objects, click Save. To quit the window without saving, click Cancel.

To restore the saved settings and database, see Restore Dispatcher Settings.
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1.6.12  Restore Dispatcher Settings

To restore the saved dispatch console settings or database (see how to save the dispatch console settings here),

open the Service menu and select Restore Dispatcher Settings. At that, the following window will open:

Archive File – specify the path to the archive folder.

Objects – define what you want to restore. You can select more than one option.

Override Dispatcher GUID – if selected, SmartPTT Dispatcher globally unique ID is replaced with the imported

value. After importing, there are two dispatch consoles with identical GUID’s. If check box is not selected,

SmartPTT Dispatcher globally unique ID is left unchanged. After importing, there are two  dispatch consoles with

same configuration settings, but different globally unique ID’s.

To restore the selected objects, click Restore. To quit the window, click Cancel. To apply the restored settings,

restart the application.

1.7  Reports
The Reports menu presents all the reports available in the system:

· Report Wizard allows you to build a report on the basis of the Event log.

· Radio Activity Report allows you to view the number of all calls and group calls during a defined time period.

· Subscriber Location Report is a special report that displays GPS coordinates of the selected radio

subscribers.

· Online Subscribers report gives you a list of registered and non-registered subscribers online.
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· Lone Workers report gives you the information about events that occur when the radio is in the Lone Worker

mode.

1.7.1  Report Wizard

Report Wizard functionality provides flexible report creation based on the information stored in the SmartPTT

Dispatcher Event Log. Using the Report Wizard it is possible to select the necessary fields for the report,

specify grouping and sorting fields, specify filtering criteria. Reports generated by the Report Wizard are exported

to Microsoft Excel.

To use the Report Wizard, expand the Reports menu in the Main Menu bar of the SmartPTT Dispatcher window

and click Report Wizard. At that, the Report Wizard window opens.

1. In the window that opened select the data source of the future report. You can select between the database

of the dispatch console and the database of the radioserver. To be able to select the radioserver's database,

make sure that the radioserver is up and running.

2. Select fields which you want to include in the report and click Next.

3. Define the structure of the report – its grouping and sorting. 
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Note: If both fields are not specified, the report will be grouped and sorted by default.

When ready, click Next.

4. Filter the report by values. Click Next to continue.

5. Specify the file name of the report. To complete the process, click Finish. The report can be saved in HTML,

MHT, XLS, XLSX, CSV, and TXT formats.



252Reports

Dispatcher User GuideSmartPTT PLUS 9.1

1.7.2  Radio Activity

Radio Activity Report gives information about quantity and duration of All Calls and Group Calls with a breakdown

into hours or days.

To create the report, expand the Reports menu and select Radio Activity Report. The Radio Activity Report

window opens.
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Period – defines the time frame for the report data.

Source – defines the source, which database will be used for the report. If Dispatcher is selected, the data is

taken from the local database. Apart from Dispatcher, any available radioserver can be chosen as a data source.

In that case all data is taken from the database of the chosen radioserver.

Channel – allows to build a report for a particular channel of for all control stations.

Group by – defines the level of detail, whether you want to see the report information divided into days, hours or

minutes.

The report can be saved in PDF, HTML, MHT, RTF, XLS, XLSX, CSV, TXT, Image or XPS formats.
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1.7.3  Subscriber Locations

SmartPTT Dispatcher allows creating a report on subscriber's locations. The report can be saved in PDF, HTML,

MHT, RTF, XLS, XLSX, CSV, TXT, Image or XPS formats.

To create the report, expand the Reports menu in the Main Menu and click Subscriber Locations. At that, the

Subscriber Locations window will open.

Period – defines the time frame of the report.

Source – defines the source, whose database will be used for the report. If Dispatcher is selected, the data is

taken from the local database. Apart from Dispatcher, any available radioserver can be chosen as a data source.

In that case the data is taken from the database of the chosen radioserver. To build a report based on the

radioserver database, make sure that Event Log is enabled and connected in SmartPTT Radioserver Configurator.

Subscriber – defines subscriber for whom the report is to be generated. The list of subscribers is taken from the

current database. When All is selected, the report will be generated for all subscribers which have GPS

coordinates in the database.

Group by subscribers – groups data in the report by radio subscribers.

UTC Time – if selected, the report time will be converted to UTC format. If UTC Time is not selected, the local

time of the radioserver PC will be shown in the Subscriber Locations report.



256Reports

Dispatcher User GuideSmartPTT PLUS 9.1

RSSI – if selected, the signal strength of the received signal (RSSI) is displayed in the report.

Address – allows displaying address information based on the received coordinates. The addresses are received

from one of the two services Google Maps or OpenStreetMap. The service is selected in Settings > Positioning

Systems > Address Data Provider. If the Address check box is not selected, there will be a link Find on Map

instead of the address. You can use the link to see the address.

Route – defines the route on the basis of which the Subscriber Locations report is to be generated.

Only Key Point – displays only the key points of the route in the report.

Click OK to create the report.

In order to set up the format of Latitude, Longitude, Speed and Precision columns of the Subscriber

Location Report, see Positioning Systems, the GPS tab, in SmartPTT Dispatcher.
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Note: The Universal Transverse Mercator Coordinate System format is not applicable to this report. If it is

selected, Latitude and Longitude are displayed in Decimal degrees format.

1.7.4  Online Subscribers

SmartPTT allows exporting online subscribers (registered and not registered) in no time by means of the Online

Subscribers report.

To create the report, expand the Reports menu in the Main Menu bar of the SmartPTT Dispatcher window and

click Online Subscribers. At that, the following window opens.

All – select this radio button to include all registered and not registered online subscribers in the report.

From ... to ... – select this radio button to limit the number of subscribers in the report.

Click OK. At that, the report opens. The report can be exported to PDF, HTML, MHT, RTF, XLS, XLSX, CSV, TXT,

Image or XPS formats. The report contains three columns: Radio ID, Channel Type and Name. The Channel

Type column can have three values: MOTOTRBO, Analog, Select 5.



258Reports

Dispatcher User GuideSmartPTT PLUS 9.1

1.7.5  Monitoring Reports

Monitoring Reports allow creating the following reports:

· Monitoring Report,

·  Event Log Report,

·  Analytic Report,

·  System Usage Report.

They are based on the data collected during the monitoring and filtered by different criteria.

To create a report, in the Main Menu bar click Reports, point on Monitoring and click the needed type of report.

Note:  Before creating a report, make sure the radioserver is running and Monitoring is active in SmartPTT

Radioserver Configurator.

Monitoring Report

Monitoring Report gives such information as repeater ID, ID's of the calling and receiving parties, duration of the

event and its type, RSSI and many other.
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To create the report, expand the Reports menu in the Main Menu bar and under Monitoring select Report. At

that, the following window appears.

Period – defines the time frame of the report.

Radioserver – defines the radioserver, whose database you want to use as a data source.

System – defines the radio system for which you want to build a report. In the drop-down list you can find both

existing and removed radio systems. Network IDs are used for outdated radio systems, and names—for existing

ones.

Subscriber – selects the subscriber for whom the report is to be generated. If you select All, the report will be

generated for all registered subscribers.

UTC Time – if UTC Time is selected, the report time will be converted to UTC format. If UTC Time is not

selected, the local time of the radioserver PC will be shown in the report.

Sort By – you can select the column by which you want to sort the report data: network, repeater, slot, protocol,

sender, receiver, duration, RSSI.

Event Log Report

Event Log Report shows information about available devices in the system (e.g., repeaters, routers,

uninterruptible power supplies) and alarms registered on these devices.

To create the report, expand the Reports menu in the Main Menu bar and under Monitoring select Event Log.

At that, the following window opens.
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Period – defines the time frame of the report.

Radioserver – defines the radioserver whose database you want to use as a data source.

After clicking OK, the report opens automatically:

Analytic Report

Analytic Report is a graphical representation of the data received during a monthly monitoring process.

To build a report, expand the Reports menu in the Main Menu bar, and under Monitoring select Analytics. At

that, the following window opens.
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Start Date – specify the start date of the report. This is a monthly report, so the end date is calculated

automatically.

Radioserver – select the available radioserver whose database will be used as a data source. 

Network – select the radio system for which you want to build a report. The drop-down list contains all radio

systems which have been ever used. Network ID’s are used for old networks, and names—for existing ones.

Site – select a site. This is used for Linked Capacity Plus networks. You can also build a report for all existing

sites, or select no sites at all.

Repeater – select the particular repeater. You can also build a report for all repeaters.

Subscriber – select the subscriber for whom the report is to be built. You can build a report on all subscribers

from the drop-down list.

Report sample:
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Export – allows you to save the report in HTML format for further use.

System Usage Report

System Usage Report provides information on the system load, operation time of the system, downtimes, and

other information. To build the report, expand the Reports menu in the Main Menu bar and under Monitoring

select System Usage. At that, the following window opens.
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Period – defines the time frame of the report.

Radioserver – select the available radioserver whose database will be used as a data source. 

System – defines the radio system for which you want to build a report. In the drop-down list you can find both

existing and removed radio systems. Network IDs are used for outdated radio systems, and names—for existing

ones.
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After setting the parameters, click OK and the report will open in a new window.

1.7.6  Lone Workers

The Lone Workers report provides information about the radio subscriber events when the radio is in the "lone

worker" mode, for example, registration on the network, the incoming or outgoing calls and messages.
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To create the report expand the Reports menu in the Main Menu bar of the SmartPTT Dispatcher window and

select Lone Workers. The Lone Workers window opens.

Period – defines the time frame for the report data.

Subscriber – defines the subscriber for whom the report is to be generated. The list of subscribers is taken from

the connected database.

Sort By – defines the sorting field for the report events. Sorting parameters: direction, event type, date and time,

additional information, operator, control station, subscriber, group, status, duration, repeater IP address, receiver.

The report can be saved in PDF, HTML, MHT, RTF, XLS, XLSX, CSV, TXT, Image or XPS formats.

1.7.7  Radio Subscribers Movement

The Radio Subscribers Movement report provides information about the radio subscribers movement on the

basis of received GPS data.
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To create a report, on the Reports menu click Radio Subscribers Movement. At that, the following window

opens.

· Period: Defines the time frame for the report data.

· Select radio subscribers: Select the subscribers whose GPS data will be used to build the report.

· Select categories: Select the subscribers categories whose GPS data will be used to build the report.

· Source: Defines the source, whose database will be used for building the report for selected radio

subscribers or categories. If Dispatcher is selected, the data is taken from the local database. If a radioserver

is selected, the data is taken from the database of the chosen radioserver.

· Minimum stop time interval (min): Used to define the time when the subscriber stops. If the subscriber

stays at the same place longer than the specified time interval, the subscriber is supposed to be parked.

· Enable points of interest: Select to use the points of interest when building the report.

Note: When Enable points of interest is selected, in the Radio Subscribers Movement report the

Location field will contain only the name of the point of interest.

· Radius (m): Specify the allowed distance deviation from the point of interest.
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Note: The Radius field is available only if Enable points of interest is selected.

To build the report, click OK. To cancel this action, click Cancel.

After clicking OK, the report opens automatically. The report can be saved in the PDF, HTML, MHT, RTF, XLS,

XLSX, CSV, TXT, Image or XPS formats.

1.8  User Interface Layout

The UI Layout Settings button   in the Main Menu bar contains two features:

· Locking the layout of the user interface of the dispatch console (for more information see Lock UI Layout)

· Customization of the layout of the user interface of the dispatch console: 

When working with SmartPTT Dispatcher the operator opens many different windows. Some of them are used

very often. Usually, at every launch of the application all the windows are closed and the operator needs to

spend considerable time to configure the main area. This is quite inconvenient and time-consuming. In order

to avoid this, the operator can save his/her windows configuration at the end of the work day, prior to the

application shutdown, and restore the configuration the next day. There can be more than one window

configuration and the operator can switch between them. To save the current layout of the application user
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interface for future use, select Set UI Layout, and then click Add. Enter the name of the user interface

layout. To restore the selected user interface layout, click Apply. To delete the saved user interface layout,

click Delete.

There are two default window configurations, which can't be deleted:

· Calls and Event log. It opens Calls, Radio Fleet, Sound and Event Log.

· Calls, Channels and Event log. It opens Calls, Radio Fleet, Sound, Channels and Event Log. 

 

1.8.1  Lock UI Layout

Locking user interface layout feature is available only for Administrator account and allows blocking any dispatch

console layout changes for operators. It allows administrator to do specific console customization and prevent

ordinary dispatchers from opening and closing windows and panels.

In order to fix panel positioning, click  and then select Lock UI Layout.

When this mode is enabled, the dispatcher can't do the following actions:

· Opening and closing panels. Automatic pop-up panels, such as Notifications and System messages, do

not open either.

· Changing panel location (see Changing Layout).

· Switching user interface layouts.

· Changing the size of the opened panels.

· Changing the content of the Radio Fleet panel.

Note: If the Event Log is opened when the user interface layout is locked, all the features designed for the Event

Log management are available to the dispatcher.

1.9  Bridging
SmartPTT Bridging service allows joining multiple network systems into a single radio network. The bridging

service is implemented by SmartPTT Radioserver and provides intelligent means of patching for voice and data

streams between various network systems.

In SmartPTT Plus the bridging service allows you to :

· join various radio networks;
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· bridge two or more radioservers to cover distributed regions;

· bridge selected voice and data;

· bridge private and group calls dynamically;

· break the barrier of 15 repeaters per IP Site Connect;

· have calls bridged with only a short voice delay (from 60 ms), when joining IP Site Connect systems.

Radio network configurations supporting bridging:

1. NAI networks

2. Connect Plus networks. The current version of SmartPTT Dispatcher supports only talkgroup call exchange

between Connect Plus networks and analog control stations, digital control stations (analog or digital

conventional channels), NAI networks (the Voice connection type) or Connect Plus networks. Bridging of

Connect Plus networks with other network types is not supported yet. Any other data exchange between

Connect Plus and other networks is not supported yet.

3. SIP/RTP interfaces

4. External SmartPTT Radioservers

5. Digital conventional channels. Private calls or data can't be bridged in networks based on control stations.

6. Analog conventional channels. Private calls can't be bridged in networks based on control stations.

How to Configure Bridging in SmartPTT Dispatcher Console

You can configure bridging settings in the call bridging table in SmartPTT Dispatcher. The main idea of the

configuration process is to manage bridging with the help of the so-called "Profiles" and "Route Groups". The

profiles contain information on the bridging rules, which are specified in route groups and further in routes. So,

there are three levels:

1. Routes

2. Route Groups

3. Profiles

Route – a basic unit of the bridging process and an integral part of the route group, that is a route cannot be used

separately. It is in the route where you define the source and the destination networks, and other main

characteristics of the route.

Route Group – group which unites several routes. It was designed to provide a neat look to profiles. Route groups

can be easily activated and deactivated, which will either make routes inside route groups usable or not usable.
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Profile – saved template of route groups. Profiles can be created for various business fields, for example, there

can be profiles for general purposes, for carrying out engineering work or for emergency situations, etc.

You can configure bridging settings individually for each radioserver from SmartPTT Dispatcher. To open the call

bridging table, open the Actions List by clicking the button  next to the radioserver and select Configure

Call Bridging Table.

At that, the Bridging Configuration window opens.

This is the main window from where you can create routes, route groups and add them to new profiles. The

window also informs about the name of the current radioserver, its current profile, the list of available routes

organized in groups.

Show Details – displays details of the route groups. You can also check the details of a particular route group by

clicking a plus sign next to the route group name.
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Hide Details – displays only route group names and the Active check box.

By default, the bridging table displays only active route groups, which belong to the selected profile. To display all

route groups, select the All option.

The buttons Change Profile, Save, Save As allow you to create a new profile or edit the existing one.

The buttons Add Group, Edit Group, Delete Group allow creating new route groups and attach routes to

groups.
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1. Profiles

Profiles are used for quick switching between predefined bridging tables.

To add, modify or delete a profile, click Change Profile in the Bridging Configuration window.

If No Profile is selected, the created groups have no reference to a specific profile. The profile list and buttons for

profile edition are not available in the Bridging Profiles window.

If Select Profile is enabled, the profile list is available for editing and route groups can be assigned to the

selected profile.

In the Bridging Profiles window, click Add to create a new bridging profile. At that, the Enter Profile Name

window opens. Use the Profile Name field to specify the profile name, click OK.

Left-click on the profile name in the Bridging Profiles window and click OK.
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In the list of groups, select Active check boxes near the route groups that should apply to the chosen profile.

As you finished editing the profile settings, click Apply to activate the current profile settings. At that, the asterisk

character ("*") appears in front of the profile name.

Click Save to save the profile settings.
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To switch the profile, click Change Profile in the Bridging Configuration window, select a profile from the list

and click OK. The Bridging Configuration window displays settings of the selected profile – active route groups.

Save As allows you to save a copy of the current profile with a new name.

2. Route Groups

To create a new bridging route group and add routes to it, click Add Group in the Bridging Configuration

window.

In the Route Group window, specify name of the route group, add routes to the group and click OK.
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To save the changes in the route groups, click Apply.

Add routes to the group by clicking Add Route in the Route Group window. At that, the window for adding routes

opens up.

This is the window where you create routes. Here you can define the source and the target networks, route

direction (one-way or two-way), the source radio or talkgroup and the target radio or talkgroup. You can also

select the Route Type, which depends on the data type you want to patch.

Here you can find a detailed description how to configure routes of different types.

2.1. Configuring "All" Route Type

If you need to patch all voice and data packets from the source network to the destination network, select All in

the Route Type.

In this case you need to fill in the following fields:

Route Number – ordinal number of the route.

Source Control Station – select any of the added control stations serving as a source. You can add control

stations of various networks in SmartPTT Radioserver Configurator. 

Destination Control Station – select any of the added control stations serving as a destination. You can add

control stations of various networks in SmartPTT Radioserver Configurator.

Direction – allows you to select either one-way or two-way.
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Process Routed Calls – if selected the call which is already routed once (by one route) also can be routed

another time by another route. It takes place only when several routes are added.

 Example:

 You can add all these routes without the Process Routed Calls check box selected:

 IPSC 01 slot 01 <---> IPSC 02 slot 01 

 IPSC 01 slot 01 <---> IPSC 03 slot 01

 IPSC 01 slot 01 <---> IPSC 04 slot 01

 IPSC 02 slot 01 <---> IPSC 03 slot 01

 IPSC 02 slot 01 <---> IPSC 04 slot 01

 IPSC 03 slot 01 <---> IPSC 04 slot 01

 Or, you can select the check box and create only three routes:

 IPSC 01 slot 01 <---> IPSC 02 slot 01

 IPSC 02 slot 01 <---> IPSC 03 slot 01

 IPSC 03 slot 01 <---> IPSC 04 slot 01

Warning! Please don’t use round routes. They can cycle all routes and lead to unstable system

operation (for example, IPSC 01 slot 01 <---> IPSC 04 slot 01).

2.2. Configuring "Talkgroup" Route Type

In order to patch a group call, select Talkgroup in the Route Type. Specify the source and the destination

networks, and other parameters as if you were configuring the "All" Route Type. 
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The only difference is that for this route type you need to specify the groups' IDs, that is the source talkgroup ID in

the Source field and the destination talkgroup ID in the Target field. For All Call, use "0" as Source ID or Target

ID.

2.3. Configuring "Subscriber" Route Type

Note: This route type is not supported in SmartPTT Basic, since private calls can't be bridged in control station

networks.  

To patch individual calls or text messages, select Subscriber in the Route Type field. 

Specify the source and the destination networks, and other parameters as if you were configuring any of the

previous route types. 
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In the Source field specify the subscriber radio ID from the source network. The Target field will be populated

automatically. In this case, all the subscribers from the destination network (see Destination Control Station)

will be able to call to radio subscriber 123 and v.v. 

2.4. Configuring "Dynamic" Route Type

Note: This route type is not supported in SmartPTT Basic, since private calls can't be bridged in control station

networks.  

To patch private voice calls or text messages of the subscribers from the Subscriber Groups, select Dynamic in

the Route Type field. 
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In the Subscriber Group select a group, which was added in Subscriber Group of SmartPTT Radioserver

Configurator.

Once created, the routes will display in the Route Group window. Here is the example of the route group

containing routes of three types (All, Group, Subscriber).

Activating Bridging Service

To activate Bridging Service:

1. Run SmartPTT Radioserver Configurator,

2. Click Bridging,

3. Select Active,

4. Save changes and restart the SmartPTT Radioserver.

1.10  Conference Calls
The Conference Call is a type of call in which the dispatcher can have more than one subscriber of different

types at a time. At that, all the participants of the conference call can hear and talk to each other.
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SmartPTT Dispatcher allows the dispatcher to organize conference calls and to connect the following subscriber

types:

· Telephone subscribers

· Other dispatchers using SmartPTT Dispatcher

· Radio subscribers

· Talkgroups

Note: To be able to make conference calls, the dispatcher must have the permission “Make conference calls”.

To organize a conference call, click the Conference Call button   in the Main Menu bar of SmartPTT

Dispatcher. 

At that, the Conference Call window will appear.

To add a subscriber to the conference call, unfold the the necessary section and double-click on the subscriber,

or use drag-and-drop.
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The button  turns off the sound of the conference call. At that, the dispatcher's microphone is turned off

automatically. So the operator does not hear the conference call participants, and the participants cannot hear the

dispatcher.

The button  turns off the operator's microphone.

Stop: Click the button to end the current conference call. Should the radio subscriber make a call right after the

conference call, it is necessary for him or her to wait for a special tone notifying about the end of the call. If the

radio subscriber presses the PTT button before this tone, an incorrect phone call will be initiated.  

Starting from version 8.6 you can hold conference calls with radio and telephone subscribers without enabling

Telephone Interconnect in SmartPTT Radioserver Configurator. For more information on how to do it, see help of

SmartPTT Radioserver Configurator (Telephone Calls). 

To finish the ongoing conference call with one of the participants, click the button  next to the participant. 

There is another way how to organize a conference call.

1. In order to invite an external dispatcher or a telephone subscriber, click the buttons  or 

respectively. In the windows that opened select a dispatcher or a telephone subscriber, and click 
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Dispatcher:

Note: Only dispatchers from the Dispatcher List with status Active can be invited into the conference call.
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2. Use Actions List to make a conference call. At that, the Conference Call window appears and the call

is initiated.

1.11  Help
The Help menu includes:

·  Help. Here you can find useful information on the system objects and functionality. You can also open the

SmartPTT Help file any time by pressing F1.

·  About. It contains information on the application version, license, and the third-party software used in

development process.
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· Check for Updates.

1.12  Remote Assistance
SmartPTT contains Remote Assistance program which provides the remote access to your computer for

SmartPTT technical support engineer. Using this program he can resolve technical issues on your computer.

To use Remote Assistance program:

1. Run Remote Assistance program from the Start menu.

2. Contact technical support engineer and pass your ID and password to it.

3. When the connection is established, you will see session window on the screen.
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4. Chat function can be used for communication with the engineer.

5. To stop the session, click Close  .
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